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1. About SpectraSmart 

SpectraSmart is a software program for the portable spectrometers system “SEC2020 

Spectrometer system”. It offers a wide variety of optical measurements including 

spectrum, absorbance, transmittance, reflectance, emission intensity, and concentration. 
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2. Minimum System Requirements 

Before installing SpectraSmart, ensure that your computer meets the following minimum 

requirements: 

Minimum System Requirements 

Processor 1 GHz or higher 

RAM 1 GB or higher 

Hard Disk 100 MB or higher 

Screen Resolution 1024 x 768 or higher 

Operating System Windows 10, Windows 8.1, Windows 7 

Software Microsoft .NET Framework 3.5 
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3. Installing SpectraSmart 

Before Installation 

Before installing SpectraSmart, ensure that you have the administrator privilege to the 

computer where SpectraSmart is being installed. 
 

Installing SpectraSmart Software 

Insert the software USB memory into the computer, and then the installation will start. If 

it doesn't start automatically, navigate to the USB memory. Double-click on the 

"setup.exe" file to start up the program installation. 

Note: Before installing SpectraSmart, the setup program will check whether the 

"Microsoft .NET Framework 3.5" component is installed on the computer. If it is 

not installed, the following window will appear to help you install this 

component. Follow the instructions on the window to install ".NET Framework 

3.5." 

 

 

Figure 3-1: Installing ".NET Framework 3.5" 
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When the installation of Microsoft .NET Framework 3.5 is confirmed, the setup wizard 

starts up. Execute the installation by following the instructions on the screen. 

Figure 3-2: Windows Security Alert - select run 

 

 

Figure 3-3: Setup Wizard -- Welcome 
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Figure 3-4: Setup Wizard -- Select Installation Folder 

 

 

Figure 3-5: Setup Wizard -- Confirm Installation 
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Figure 3-6: Setup Wizard -- Installing SpectraSmart 

 

 

Figure 3-7: Setup Wizard -- Installation Complete 

 

When you see the Installation Complete window, it means that SpectraSmart has been 

successfully installed. Click Close to finish. 

Installing Device Drivers 

Normally, device drivers for supported spectrometers will be installed with SpectraSmart 

as part of the setup process. If they are not installed due to unexpected errors, you need 

to install these drivers manually. Files for these drivers will be copied to the "Driver" 

folder under the installation path for SpectraSmart during the setup. If you have selected 
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the default path, the drivers will be in: 

C:\Program Files\ALS\SpectraSmart\Driver\USB2.0    (32-bit systems) or  

C:\Program Files (x86)\ALS\ SpectraSmart \Driver\USB2.0   (64-bit systems) 

Under this folder, there are sub-folders for each series of spectrometers: 

Windows 10/8.1/7 

Please run the "DriverInstaller.exe" program on the USB memory or under the 

SpectraSmart installation folder to install the drivers. Or, connect the spectrometer to the 

computer, enter in the "Device Manager", manually specify the folder with the "TAURUS" 

device driver, and update the driver. Specify the folder location of the appropriate drivers, 

as shown in the following figure:  
 

 

 

Figure 3-8: Manually specifying the location of drivers on 64-bit Windows 7 

After you have specified the path, click Next to finish driver installation. 

 

If you need more detailed explanation, please contact us. 
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4. Removing SpectraSmart 

If you need to remove SpectraSmart, go to the Control Panel and follow the instructions 

below: 

Note:  To open the Control Panel on Windows 10, right-click on the “Start” button, and 

then select “Control Panel” from the pop-up menu. 

Windows 10/8.1/7 

Open the Control Panel. Navigate to Programs and then Programs and Features. Select 

SpectraSmart from the list, and then click Uninstall. The system will ask you to confirm 

the removal. After the confirmation, you will see a message box showing the removal 

progress. When it is finished, this message box will close. 
 

 

Figure 4-1: Confirming the removal of SpectraSmart (on Windows 10/8.1/7 systems) 

 

 

Figure 4-2: The system is removing SpectraSmart (on Windows 10/8.1/7 systems) 
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5. Getting Started with SpectraSmart 

Starting SpectraSmart 

A shortcut to the SpectraSmart program will be placed on your computer desktop during 

the installation. See the following figure: 

 

Figure 5-1: SpectraSmart program shortcut on the desktop 

 

Double-click the shortcut to activate the Spectra Smart. After starting the program, the 

following screen will be displayed. When the spectrometer is not connected, the "Device 

list" frame at the bottom left is blank. 

 

Figure 5-2: SpectraSmart not yet connected to the spectrometer 
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Next, connect the spectrometer to the computer where SpectraSmart is installed. When 

SpectraSmart detects the device, the following message will appear, indicating that the 

device is being initialized: 

 

 

Figure 5-3: SpectraSmart is initializing the measurement device 

 

After the device is initialized, you can use the device in SpectraSmart for a wide variety of 

spectral measurements. When you see the following, it means that SpectraSmart is ready 

for measurements: 

Figure 5-4: SpectraSmart is ready for measurement 

 

Now, you can create a new measurement from the Measurement menu. Or, you can load 

a previously saved measurement or a set of measurement settings from the File menu. 
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If you connect the spectrometer first...  

If you connect the spectrometer to your computer before you start SpectraSmart, it will create a 

default spectrum measurement for the connected device on startup, allowing you to ensure that the 

device is working properly. See the following figure: 

 

Figure 5-5:  SpectraSmart creates a default spectrum measurement for the connected device on startup 

If there is more than one spectrometer connected to your computer when SpectraSmart starts, it will 

create a default spectrum measurement for each device connected, and there will be more than one 

device in the Device List. See the red highlighted area in the figure below. 

 

Figure 5-6: On startup, SpectraSmart creates a default spectrum measurement for each connected spectrometer (i.e. 

https://www.als-japan.com/


SpectraSmart User's Guide 5. Getting Started with SpectraSmart 

  
https://www.als-japan.com/      17 

 

Spectrum_0 and Spectrum_1) 

Device List 

When SpectraSmart recognizes the spectrometer, it will display it in the Device List pane 

on the left of SpectraSmart window, as shown in the following red highlighted area: 

 

Figure 5-7: The Device List of SpectraSmart 

 

The Device List shows the basic attributes of connected devices, such as models, serial 

numbers (SN), and wavelength ranges. 

Note:  The serial number is how SpectraSmart identifies each device. This number is 

also used in several windows where device selection is needed. For this reason, 

when you have multiple devices connected, please pay attention to their serial 

numbers so you can identify them. 

Device Information Details 

If you need to view detailed information about a connected device, go to the File menu, 

and then select Device Information, as shown in the following figure: 
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Figure 5-8: Selecting Device Information from the File menu 

 

Then, the following window appears, showing details about the device: 

 

Figure 5-9: Device information details 
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6. Spectrum Measurement 

SpectraSmart can work with portable spectrometers in a wide variety of spectral 

measurements including spectrum, strip chart, absorbance, transmittance, reflectance, 

emission intensity, and concentration. This chapter describes how to create basic 

spectrum measurements. The chapters that follow will describe how to create other 

spectrum-based measurements. 

Before the Measurement 

Before doing any measurements, you should set up the measurement environment, such 

as positioning the spectrometer on the measurement platform, connecting the light 

source to the spectrometer's input connector, placing the cuvette holder in position, etc. 

For details of the method of setting the measuring instrument, refer to "SEC 2020 

Spectrometer System User's Guide - Device -". 

Creating a Spectrum Measurement 

To create a spectrum measurement, select Spectrum from the Measurement menu to 

open the New Spectrum window, as shown in the following: 

 

Figure 6-1: Selecting Spectrum from the Measurement menu to create a spectrum measurement 
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Figure 6-2: New Spectrum - Live Spectrum Settings 

 

On the New Spectrum--Live Spectrum Settings window, select a source device (identified 

by its serial number). Then, enter an integration time (i.e. the exposure time for the light 

sensor) and a wavelength range to display on the X-axis (the range in the parentheses 

indicates the range supported by the selected device, in this case: 200 nm-1025 nm). 

Then, click Next. 
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Figure 6-3: New Spectrum - Display Settings 

 

On the Display Settings window, specify whether to display the new spectrum curve in a 

new or an existing window. If this is the first spectrum measurement you create, you can 

only select a new window. If you already have other spectrum measurements, you can 

choose to display this new spectrum curve in an existing window. That way you can 

compare how two spectrum curves differ from each other. This window also allows you to 

specify a name for the window, as well as a title and a color for the spectrum curve. You 

may simply leave the default names unchanged. When all settings are done, click OK. 

SpectraSmart will display the newly created spectrum measurement as follows: 
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Figure 6-4: Newly created spectrum measurement (Spectrum_0) 

Spectrum List 

Whenever you create a measurement, the Spectrum List on the left-hand side of 

SpectraSmart window will show details about the underlying spectrum(s) of the created 

measurement. 

Note:  In addition to spectrum measurement, the setting conditions (eg. absorbance, 

transmittance, etc.) added in others measurements are also displayed. 

Not Showing Human Visible Spectrum 

For the user to read the spectrum graph more easily, SpectraSmart shows human visible 

spectrum on the graph by default. If you don't want to display visible spectrum, go to the 

Settings menu, and then select Application Settings. On the Graph tab, disable Show 

human visible spectrum and click OK, as shown in the following. 

 

Figure 6-5: Selecting Application Settings from the Settings menu 
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Figure 6-6: Application Settings -- Disabling Show human visible spectrum 

 

You will see the effect after you disable Show human visible spectrum, as in the 

following: 

 

Figure 6-7: Not showing human visible spectrum on the spectrum graph 
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Modifying Data Acquisition Settings 

If necessary, you can adjust the data acquisition settings after a measurement is created, 

such as the integration time, the number of scans to average, and the Boxcar width. You 

can do so with the quick adjustment toolbar right under the main menu. See the 

following red highlighted area: 

 

Figure 6-8: Modifying data acquisition settings 

Additionally, the three buttons (E, L, and I) to the right of the Boxcar width allow you to 

enable or disable Electronic Dark Correction, Linearity Correction, and Intensity 

Correction, respectively. Refer to “Appendix A: Spectrometer Correction Features” for 

details. The last three buttons on the right allow you to take a One Shot measurement, 

and to Start and Pause the data acquisition, respectively. Refer to “  
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One-shot Measurement” for details. 

Data Distorted 

When adjusting the integration time, a warning message "Data distorted: The peak of the 

raw spectrum has exceeded..." is displayed, as shown below. 

 

Figure 6-9："Data distorted" warning message 
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It means the integration time you specified is too long that the peak in the raw spectrum 

data acquired by SpectraSmart has exceeded the maximum allowed value (i.e. 65535). 

The captured data is meaningless now, and the spectrum curve appears distorted. You 

need to re-adjust the integration time to allow the peak to fall within the maximum range. 

Sometimes, the spectrum curve may seem normal when you see the "Data distorted" 

warning, as in the following: 

 

Figure 6-10: "Data distorted" warning appears on a seemingly normal curve 

 

This is because the curve in the graph is the result of automatic corrections. In fact, the 

raw data is out of permitted range, although its curve looks normal. That is why you still 

need to adjust the integration time until the warning message disappears. 

Note:  If you don't want to see this warning message, you can turn it off in the 

Application Settings. Please refer to "Display a Message when the Peak Value in 

the Spectrum Exceeds 65535" for details. 

Setting Integration Time Automatically by SpectraSmart 

In addition to manually specifying an integration time, you can also use a toolbar button 

to let SpectraSmart set the integration time automatically for you. Please refer to "Setting 

Integration Time Automatically" for details. 
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Graph Toolbar Buttons 

Every measurement graph has a toolbar of buttons right above it. They provide quick 

access to frequently used functions. See the following figure: 

 

Figure 6-11: Graph toolbar buttons 

 

These buttons are divided into two major groups: Scale Adjustment Buttons and Other 

Easy Access Buttons. 

Scale Adjustment Buttons 

By default, all measurement graphs (including spectrum graphs, strip charts, absorbance 

graphs, etc.) are created with optimal display scales for X- and Y-axes chosen by 

SpectraSmart. Sometimes, the scales may not fit your needs. So, SpectraSmart provides a 

set of toolbar buttons for you to customize the scales and display ranges. See the 

following red highlighted area: 

 

Figure 6-12: Scale adjustment buttons on the spectrum graph 

 

These buttons are explained in details in the following. 
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Scale Graph Axes Automatically 

 

Figure 6-13: The Scale graph axes automatically button 

This button automatically adjusts the X- and Y- axes to their optimal settings. The 

following figure shows the effect of this button. In the figure, the X-axis is adjusted to 

display the entire wavelength range supported by the device, while the Y-axis is adjusted 

so that the curve fills the entire graph as much as possible: 

 

Figure 6-14: The effect of using Scale graph axes automatically 
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Scale Y-axis Automatically 

 

Figure 6-15: The Scale Y-axis automatically button 

 

This button automatically adjusts the scale of Y-axis to show more details. The following 

figure shows the effect of this button. In the figure, the highest point on the curve is 

extended to the top of Y-axis: 

 

Figure 6-16: The effect of using Scale Y-axis automatically 
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Scale X-axis Automatically 

 

Figure 6-17: The Scale X-axis automatically button 

 

This button automatically adjusts the scale of X-axis to show more details. Using this 

button will adjust the X-axis to display the internal wavelength range of the device, as in 

the following figure: 

 

Figure 6-18: The effect of using Scale X-axis automatically 

 

Note:  If the original X-axis setting is already displaying the internal wavelength range 

of the device, pressing the "Scale X-axis automatically" button will not cause any 

change. You can try to zoom in on the graph, and then press the button to see its 

effect. 
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Zoom In 

 

Figure 6-19: The Zoom In button 

 

This button enlarges the graph (pulling it closer to you). Here we press Scale graph axes 

automatically to restore the graph to its optimal display settings, and then press Zoom In 

to demonstrate its effect. The following figure shows the result of pressing Zoom In three 

times (to make it more apparent): 
 

 

Figure 6-20: The effect of pressing Zoom In 
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Zoom Out 

 

Figure 6-21: The Zoom Out button 

 

This button shrinks the graph (pushing it away from you). Here we first zoom in on the 

graph three times, and then press Zoom Out twice to demonstrate its effect. See the 

following figure: 
 

 

Figure 6-22: The effect of pressing Zoom Out 

 

Note:  Keep pressing the "Zoom Out" button will bring the graph back to its default 

settings, and the graph will not shrink any further. 
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Revert Graph Settings to Application Defaults 

 

Figure 6-23: The Revert graph settings to application defaults button 

 

This button restores the graph display settings to application defaults (i.e. the original 

settings when the graph is created). To demonstrate, we press this button to restore the 

graph in the former example to its default settings. See the following figure: 

 

Figure 6-24: The effect of reverting graph settings to application defaults 
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Graph Settings 

 

Figure 6-25: The Graph Settings button 

 

This button opens the setting details of X- and Y-axes, as shown in the following: 

 

 

Figure 6-26: The Graph Settings window 

 

The Graph Settings window allows the user to customize the minimum and maximum 

values for X- and Y-axes, as well as the size of a major step. Here we configure the X-axis 

(wavelength) range to fall within 200 to 1025 (nm), with a major step of 100. Then, we 

configure the Y-axis (signal intensity) range as 0 to 50000, with a major step of 5000. See 

the following figure for the result: 
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Figure 6-27: Using custom X-, Y-axes 

 

Other Easy Access Buttons 

The following sections describe the other easy access buttons on the toolbar. 

Checking Spectrum Values 

The spectrum curve gives you a quick glimpse of the characteristics of the light being 

measured. In addition, you can check the actual value of a specific wavelength by placing 

the mouse cursor over a point on the curve. As shown in the figure below, when you 

move the mouse cursor to the bright line derived from D2, the actual wavelength 

(655.91) is displayed at the top of the graph and the data value (42109.15) is displayed on 

the right side of the graph. 
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Figure 6-28: Checking the value of a specific wavelength with the mouse 

 

Although the mouse cursor offers a handy way to check specific values, it does not let you 

see all the data at a glance. SpectraSmart provides a tabular spectrum data pane to the 

right of the spectrum graph to let you see all captured data in details, as in the previous 

figure. The upper half of the pane consists of a list of the underlying spectrum curves of 

this measurement ("Spectrum_0" is the only spectrum curve for this case). The lower half 

of the pane consists of two tabs. The first tab is the Spectrum Data tab that we want. It 

shows a scrollable table, which allows you to view the desired wavelength range by using 

the scrollbar on its right. 

Closing Spectrum Data Pane 

If you don't want to see this spectrum data pane, just click on the Show spectrum data 

button on the toolbar. This button allows you to turn this pane on or off: 

 

Figure 6-29: The Show spectrum data button 
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Figure 6-30: How it looks when the Spectrum Data Pane is closed 

 

Placing Marks on the Graph 

Placing Marks with the Mouse 

Although it is very handy to use the mouse cursor to check values of specific wavelengths, 

you may want to keep the values displayed on the graph so you can observe their 

variations over time or capture screenshots. SpectraSmart provides a toolbar button to 

let you place marks on the graph for this purpose: 

 

Figure 6-31: The Place marks on the graph button 

 

When you press the Place marks on the graph button and double click the left button of 

the mouse at the position where you want to mark, the data value on the graph is fixed 

and displayed. See the following figure: 

https://www.als-japan.com/


SpectraSmart User's Guide 6. Spectrum Measurement 

  
https://www.als-japan.com/      38 

 

 

Figure 6-32: The effect of placing marks on the graph 

 

In the example, a mark is placed at a wavelength of 485.94 nm (red vertical line), and its 

data value is 31537.05. 

Note:  When you place a mark with the mouse, the program automatically finds the 

peak value on the curve near the location you click and places the mark there. 

As such, it is better to click on the curve at the wavelength position where you 

want to observe, rather than clicking on the empty space on the graph. 

Otherwise, the mark may go to where the peak value appears, instead of the X 

position you click. 

Placing Marks with the Spectrum Data Pane 

In addition to using the mouse, you can also use the spectrum data pane to put marks on 

the graph, with the benefit of better accuracy in selecting the exact wavelengths you 

want. First, press the Show spectrum data button on the toolbar if you have closed the 

spectrum data pane: 
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Figure 6-33: The Show spectrum data button 

 

 

Figure 6-34: The Marks tab of the spectrum data pane 

 

The upper half of the spectrum data pane consists of a list of the underlying spectrum 

curves of this measurement ("Spectrum_0" is the only spectrum curve for this case). The 

lower half of the pane consists of two tabs. The first tab is Spectrum Data. The second tab 

is the Marks tab that we want. 

In the Marks tab, we can see the mark we created earlier is already in the list. Now, let's 

add another mark using this tab. Please enter or select a wavelength (nm) in the 

Wavelength field, and then select the mark type you want in the Type field. The available 

mark types include Normal, Peak_Intensity, Peak_Lamda, and Peak_FWHM. 
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The available four mark types are explained in the following: 

Normal: Shows the intensity of the marked position 

Peak_Intensity: Shows the intensity of the nearest peak 

Peak_Lamda: Shows the wavelength of the nearest peak 

Peak_FWHM: Shows the full width at half maximum of the 

nearest peak 

 

After specifying Wavelength and Type, click on the green '+' sign (i.e. the Add button). A 

new mark will appear at the specified wavelength position. See the following figure: 

 

Figure 6-35: Adding a mark on the Marks tab. 

 

Note:  The makeable positions of SpectraSmart are located at specific intervals. As a 

result, the program automatically places the mark at the position closest to the 

specified wavelength position. 

Deleting Marks 

If you want to delete a mark, you can select the mark you want to delete on the Marks 

tab (multiple choices can be selected at a time), and then click on the red 'X' sign (i.e. the 

Delete button) to delete it. See the following figure: 
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Figure 6-36: Click the Delete button after selection. 

 

 

Figure 6-37: The effect of deleting a mark.  
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Switching back to Spectrum Data Tab 

After adding or deleting marks on the Marks pane, you can click on the Spectrum Data 

tab to switch back to spectrum data pane. 

Turning Off Marks Temporarily 

If you want to turn of the marks temporarily without deleting the marks, you can press 

the Place marks on the graph button once again to turn off marks. The marks you placed 

before will still exist when they are turned off. You can simply press Place marks on the 

graph button again to see them. 

Statistical information 

Change the wavelength range to get the information 

Statistic Information gives you very clear characteristic of the spectrum under test, for 

example: Average, Min, Max & Centroid, and if you want to check the exact data for a 

particular wavelength range, by changing the calculated wavelength range, you can read 

the information data in the table depends on your selection. In the red frame in the figure 

below, we can read in the table: current Average, Min, Max and Centroid. 

 

Figure 6-38: Statistics Information shows the information after changing the wavelength range 
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Smoothing 

A raw spectrum curve tends to be jagged and spiky, due to the inevitable noises in the 

original signal. SpectraSmart provides a feature to eliminate such noises and smooth out 

the curve. This is a button called Smoothing on the graph toolbar. See the following 

figure: 

 

Figure 6-39: The Smoothing button 

 

Pressing this button opens the Smoothing Settings window: 
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Figure 6-40: The Smoothing Settings window 

 

On the Smoothing Settings window, several options can be selected: DWT noise filter, 

Savitzky-Golay filter, FFT filter, running average, Kalman filter, and High pass filter. You 

can enable one or all of them. 

 

Note: Most examples in this chapter have turned on the Savitzky-Golay filter with its 

default settings, i.e. "11 points" and "Reference & Measurement Curve." If all 

filters are disabled, the spectrum curve should look like the following: 
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Figure 6-41: The result of disabling "Smoothing"  

 

With smoothing disabled, the spectrum curve looks jagged. 

 

Showing Peak Values 

Sometimes you need to know the peak values on the curve when you are viewing a 

measurement graph. SpectraSmart provides a feature to automatically identify the peaks 

and show their values on the graph. Here is the button to show the peak values: 

 

Figure 6-42: Peak button 

 

When pressed, the Peak button opens the Peak Information window:  
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Figure 6-43: The Peak Information window 

 

Select Find and show peaks on the graph and set the Width of the peak searching 

window as well as a minimum value for the peak. Search for all wavelength regions with 

the set peak value search width and search the maximum value each time. If you increase 

the width of the search peak, the number of peaks to be searched will decrease. For the 

minimum value of the peak to be searched, set the lower limit of the peak to be searched. 

In this example, set the width to 350 nm and the minimum value of the peak to 30000. 

Click OK, and you will see the following result: 

 

Figure 6-44: The result of enabling Peak Information 

 

As shown in the above figure, SpectraSmart searches for peak values around wavelengths 

486, 579, 731 nm and displays data. The number before the colon (:) indicates the 

wavelength of the peak, and the number after the colon (:) indicates the intensity of the 

peak value. This intensity is the output value of the sensor, in particular there is no unit. 
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Since the minimum value of the peak to be searched is set to 30000, other peak values 

are not detected. If you lower the baseline of the peak to be searched to 20000, four 

peaks are detected as shown in the figure below. 

 

Figure 6-45: The result of lowering the minimum peak value (i.e. Find peaks above the value of) to 2000 

 

Saving the Current Spectrum Measurement 

Saving Individual Spectrum Curves from the Toolbar 

If you want to save the current spectrum measurement to a file for future reference, you 

can use the Save selected spectrum as button on the toolbar. See the following figure: 

 

Figure 6-46: The Save selected spectrum as button 

Pressing this button shows the Select Spectrum window for you to choose the spectrum 

curve that you want to save: 
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Figure 6-47: The Select Spectrum window 

 

If there are multiple spectral curves in the same window, save the spectrum individually. 

Please select the spectrum you want to save and click OK. The Save As window appears, 

which allows you to specify the destination folder and the filename (with ".sps" as the 

default extension name). See the following figure: 

 

Figure 6-48: The Save As window 

After specifying the desired folder and filename , click Save. Spectrum file is saved. The 

default for saving uses Spectrasmart's proprietary file format (.sps). You can also save in 
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CSV or TXT format. To save in CSV format or TXT format, in the Save as type of the Save as 

screen, choose [csv file (*. Csv)] or [[text file (*. Txt)].  

Note:  CSV or TXT format can only be used for other software. SpectraSmart can not 

read spectrum curves in CSV or TXT format.  

Saving Individual Spectrum Curves from the Spectrum Data Pane 

In addition to saving spectrum curves from the Save selected spectrum as toolbar button, 

you can also save individual spectrum curves from the spectrum data pane. The upper 

half of the pane consists of a list of the underlying spectrum curves of this measurement. 

Click on the spectrum curve that you want to save, and then right-click in the list to open 

the pop-up menu. Next, select Save selected spectrum as. See the following figure: 

 

Figure 6-49: Selecting Save selected spectrum as on the pop-up menu 

 

Next, the Save As window will appear. As in the previous section, please specify the 

destination folder and the filename, and then press Save to save the spectrum as a file. 

Saving All Spectrum Curves in the Current Window 

SpectraSmart allows you to display a new spectrum curve in an existing window when 

you create the spectrum measurement so that you can do comparisons. Accordingly, if 

you have two or more spectrum curves in a window, you might want to save them all at 

once, instead of saving them individually. First, press the Show spectrum data button on 

the toolbar (if you have closed the spectrum data pane). Right-click in the Spectrum list of 

the upper half of the spectrum data pane to open the pop-up window, and then select 

Save all spectrums in. See the following figure: 
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Figure 6-50: Selecting Save all spectrums in on the pop-up menu 

 

Next, you will see the Browse For Folder window, which allows you select the destination 

folder for the spectrums to be saved: 

 

Figure 6-51: The Browse For Folder window 
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When all selections are done, click OK. Then, you will see that all spectrums in the current 

measurement are saved as individual files in the specified folder. The filenames will be 

their spectrum titles, and the file extensions will always be ".sps" (in our example here, 

the saved file is "Specturm_0.sps"). 

Saving the Current Spectrum Curve as a Temporary Log 

In addition to saving spectrum curves as files, SpectraSmart allows you to save the 

current spectrum curve as a temporary log. It is like a snapshot of the current state, and it 

is kept in the same measurement graph for your reference. For example, we can create a 

spectrum graph to measure the spectrum of a certain light source. Then, under the same 

conditions, we switch in another light source to observe the differences between the two 

light sources. To demonstrate, here we create a spectrum graph to measure the spectrum 

of a white LED light source. We save its spectrum curve as a temporary log. Then, we 

switch in another light source, also a white LED, to compare their difference. Here is the 

spectrum of the first white LED: 

 

Figure 6-52: The spectrum of the first white LED 

 

Next, right-click on the Spectrum list in the spectrum data pane to bring up the pop-up 

menu, and then select Save as temporary log. See the following figure: 
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Figure 6-53: Selecting Save as temporary log on the pop-up menu 

 

Next, you will see a Please enter the temporary log spectrum name message box, as in 

the following: 

 

Figure 6-54: Please enter the temporary log spectrum name message box 

 

You can specify a name for the temporary log spectrum or simply use the default number 

as the name. For example, change the default numeric number to "LED 1". See the 

following figure: 

 

Figure 6-55: Renaming the temporary log spectrum as "LED1" 

 

Press OK. A new spectrum curve will be created in the spectrum graph (i.e. the "LED 1"): 
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Figure 6-56: A new spectrum curve called " LED1" appears in the list 

 

You will not see any changes on the graph because two spectrum curves now completely 

overlap. Next, for easier observation, go to Settings, Application Settings, and then 

Graph to turn off Show human visible spectrum. See the following figure: 
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Figure 6-57: Turning off Show human visible spectrum  
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Figure 6-58: The effect of turning off Show human visible spectrum 

 

Next, switch the light source to the second white LED, and the result looks like this: 

 

Figure 6-59: The result of switching the light source to the second white LED 

 

As you can see in the figure, although both are white LEDs, two light sources may still be 

different in their spectrums. The thinner line on the graph is the temporary log we saved 

earlier (i.e. LED 1), while the bolder line is the current Spectrum_0 (i.e. the spectrum 
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curve of the second LED). When you are done with the temporary log spectrum, you can 

delete it from the spectrum data pane. Refer to "Deleting Individual Spectrum Curves" for 

details. 

Loading Saved Spectrum Curve 

Load a previously saved spectrum curve to compare with the current spectrum curve 

being captured to see their differences. For demonstration purpose, we keep our sample 

spectrum measurement ("Spectrum_0") on the screen but place an orange translucent 

film in front of the light source to modify its color. The acquired spectrum then changes 

accordingly as the following figure shows: 

 

Figure 6-60: Using an orange translucent filter to modify the current spectrum curve 

 

Next, we load the spectrum file we saved earlier (i.e. "Spectrum_0.sps"). Go to the File 

menu, and then select Open Spectrum File: 
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Figure 6-61: Opening a previously saved spectrum by selecting Open Spectrum File from the File menu 

 

The Open Existing File window will appear: 

 

Figure 6-62: New Spectrum - Open Existing File 

 

Use the Browse button next to the File to open field to locate the file we saved earlier 

("C:\Save\Spectrum_0.sps"). Then, click Next, and the Display Settings window will 

appear: 
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Figure 6-63: New Spectrum - Display Settings 

 

On the Display Settings window, choose Select existing window to load the spectrum 

curve into the current "Spectrum_0" window. This allows us to see two superimposed 

spectrum curves so that we can compare their differences easily. Additionally, specify an 

obvious name ("Previously_Saved_Spectrum") for the spectrum to be loaded so that we 

can recognize it right away (see the red highlighted area in the former figure). Click OK 

and you will see something like: 
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Figure 6-64: Loading the previously saved spectrum curve to compare with the current spectrum curve 

 

In this example, the previously stored spectral curve (the orange line) covers the entire 

range of visible spectrum, but the current spectrum "Spectrum_0", after adding the 

orange translucent filter, only cover the orange to red wavelength range. Turn off the 

Show human visible spectrum feature to make the differences more apparent: 

 

Figure 6-65: Turning off the Show human visible spectrum feature to make spectrum curve comparison easier 
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Deleting Individual Spectrum Curves 

When there are more than one spectrum curves in a spectrum graph, you can delete the 

curve that is no longer needed. Here we demonstrate the steps to delete the curve we 

loaded in our previous example. First, in the Spectrum list of the spectrum data pane, 

select "Previously_Saved_Spectrum."  

 

Figure 6-66: Select "Previously_Saved_Spectrum" in the spectrum data pane 

 

Right-click in the spectrum data pane to open the pop-up menu, and then select Delete 

from the menu. See the following figure: 

 

Figure 6-67: Right-clicking in the Spectrum list to open the pop-up menu, and then select Delete 
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This will delete the selected spectrum curve. See the following figure: 

 

Figure 6-68: The "Previously_Saved_Spectrum" is now deleted 

 

Printing and Previewing a Spectrum Measurement 

In addition to saving the spectrum measurement to a file, you can also print it out to 

preserve it. To print the current spectrum measurement, you can use the Print Preview or 

the Print button on the toolbar. See the following figure: 

 

Figure 6-69: The Print Preview button 

 

 

Figure 6-70: The Print button 

 

Pressing the Print Preview button displays a standard Print Preview window, which 

shows the current spectrum measurement in SpectraSmart: 
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Figure 6-71: The Print Preview window 

 

You can zoom in to check the details and make sure this is the way you like it. Click the 

printer icon on the upper-left corner of the Print Preview window to start printing. If you 

don't need to preview the graph before you print it, you can simply press the Print button 

on SpectraSmart's graph toolbar to open the standard Print window: 

 

Figure 6-72: The Print window 

 

The File menu also provides the Print and the Print Preview options, and they open the 

same windows as the corresponding toolbar buttons, so we will not repeat the details 

again. In addition, the File menu also provides a Page Setup option: 
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Figure 6-73: Choosing Page Setup from the File menu 

 

This feature lets you select the desired paper, orientation, and margins:  

 

Figure 6-74:  The Page Setup window 

 

Lamp Control 

SpectraSmart can control the on/off states of an external light source via I/O signals. The 

lamp control button is right edge of the window. When this is pressed, the light source 

frame is diplayed. 
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Figure 6-75: The Lamp button 

 

The operation mode of the "light source" button has two modes of "active" and 

"inactive". Press it once to activate it, press it again to deactivate it. 

 

Figure 6-76: The Lamp button in active and inactive states 

 

Spectrum Scanning Interval 

By default, SpectraSmart captures continuous spectrum data at an interval determined by 

the user-specified integration time plus around 30 ms, depending on the processor speed 

inside the spectrometer device and the performance of the computer running the 

SpectraSmart software. As a result, if the user-specified integration time is 50 ms, the 
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spectrum data will be captured once every 80 ms. However, the user can modify this 

interval if necessary. You can find the Spectrum Scanning Interval button on the graph 

toolbar: 

 

Figure 6-77: The Spectrum Scanning Interval button 

 

Pressing the Spectrum Scanning Interval button shows the Spectrum Scanning Interval 

window: 

 

Figure 6-78: The Spectrum Scanning Interval window (at 1000 ms) 

 

Select Enable user-defined spectrum scanning interval, and then specify the desired 

Interval in the text box. Click OK when done. After the change, you will notice that the 

spectrum graph refreshes at a different speed. If you set the interval to 1000 ms, as in our 

example, the graph will refresh approximately once every second. 

Setting Integration Time Automatically 

You need to specify an integration time (i.e. the exposure time for the light sensor) when 

you create a spectrum graph. Sometimes, you may not know the best integration time to 

use for the optimal result. For this, you can create the spectrum graph with the default 

setting (i.e. 50 ms), and then use the Set integration time automatically button on the 

toolbar to let SpectraSmart determine and set the optimal integration time for you. The 

new setting will reflect on the graph after you press the button. See the following figures: 

 

Figure 6-79: The Set integration time automatically button 

https://www.als-japan.com/


SpectraSmart User's Guide 6. Spectrum Measurement 

  
https://www.als-japan.com/      66 

 

 

Figure 6-80: The effect of using the Set integration time automatically button 

 

The integration time has changed from 50 ms to 16 ms after the Set integration time 

automatically button is pressed. And the spectrum is corrected slightly downward. 

Setting as Dark Spectrum 

Set as dark spectrum is in the right of the Set integration time automatically button: 

 

Figure 6-81: The Set as dark spectrum button 

 

Refer to "Setting a New Reference Spectrum or Dark Spectrum" for details on its purpose. 

FWHM  

SpectraSmart offers the function of displaying FWHM in real time. You can click the 

FWHM button and click on any wavelength of the spectrum. The program will 

automatically find the highest peak nearby and measure its FWHM and reflect it in the 

spectrum as following shown: 
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Figure 6-82: The FWHM button 

 

Copying Spectrum Data to Clipboard 

Sometimes you might want to copy and paste the spectrum data into other applications. 

You can do this by using the Copy to clipboard button on the toolbar: 

 

Figure 6-83: The Copy to clipboard button 

 

As you press this button, all data in the spectrum data pane will be copied to the system 

clipboard. You can then paste the data into the application you want. For illustration, we 

paste the data into Windows Notepad and Microsoft Excel in the following figures: 

 

Figure 6-84: Pasting spectrum data into Windows Notepad 
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Figure 6-85: Pasting spectrum data into Microsoft Excel 
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One-shot Measurement 

In most cases, SpectraSmart acquires data continuously from the spectrometer while the 

measurement is in progress. If only one number is enough, use the One Shot button on 

the toolbar. 

 

Figure 6-86: The One Shot, Start Acquiring, and Pause buttons 

 

Before you do one-shot measurement, be sure to temporarily stop continuous 

acquisition with the “Pause” button. After that, every time you press One Shot button, 

data will be captured. To return to continuous capture, press Start Acquiring button. 

Closing a Measurement 

To end the measurement such as spectrum, strip chart, absorbance, etc., you can close it 

by pressing the X button on the upper right corner of the graph: 

 

Figure 6-87: The button to close a measurement 
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Note: When you close the graph, the measurement is also closed. If you need the 

same measurement later (such as spectrum), you need to create it again. 

Closing All Measurements Together 

In addition, SpectraSmart also provides a Close All Measurements option, which is handy 

when you need to close multiple measurements together. Please go to the File menu, and 

then select Close All Measurements: 

 

Figure 6-88: Selecting Close All Measurements from the File menu 

 

All measurements will be closed after you select the option. 
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7. Strip Chart (Tracking Specific Wavelengths) 

In order to continuously observe numerical changes of a specific wavelength or 

wavelength range, a strip chart (Strip Chart) is prepared for SpectraSmart. For the 

following explanation, first set up spectrum measurement. 

 

Figure 7-1: Creating a spectrum measurement first 

 

Striping chart setting 

Next, create the strip chart. From the Measurement menu, select Strip Chart to open a 

New Strip Chart window: 

 

Figure 7-2: Selecting Strip Chart from the Measurement menu 
 

The New Strip Chart window will be displayed: 
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Figure 7-3: New Strip Chart - Strip Chart Settings 

 

First select the desired source spectrum from the New Strip Chart-Strip Chart Settings 

window. In this case, "Spectrum_0" is selected. Then, select the wavelength or 

wavelength range and press Add. If you want to add multiple wavelengths, repeat the 

operation selecting the desired wavelengths and press Add. Then, specify Tracking 

interval on the displayed window. Select whether to synchronize with the data acquisition 

interval of the source spectrum, specify the number of scans, or specify the scan interval. 

When you press Record Setting, the Record Setting window is displayed, and you can set 

When to start, Interval for recording, and When to stop. After completing the settings, 
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press OK and then OK on the dialog box that appears. 

After completing the settings, click Next on the New Strip Chart-Strip Chart Settings 

window.  

 

 

Figure 7-4: New Strip Chart - Strip Chart Settings - Record Setting 
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Figure 7-5: New Strip Chart - Display Settings 

 

Now, on the Display Settings window, specify whether you want to display the new strip 

chart in a new window or an existing window. If this is the first strip chart you create, you 

can only select a new window. If you have any existing strip chart, you can display the 

new strip chart in the existing window for comparison. This window also allows you to 

specify a name for the window, as well as a title and a color for the curve. When all 

settings are done, click OK. SpectraSmart will display the newly created strip chart, as in 

the following figure: 
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Figure 7-6: The newly created strip chart (Strip_Chart_0) 

 

In the above figure, strip chart curves are displayed at 10-minute intervals. The X axis 

scale is the default 10 minutes. When it exceeds 10 minutes it will automatically scroll to 

the left (Figure 7-7). 

 

Figure 7-7: The chart starts scrolling after ten minutes 

 

In the figure, the scale of the start of the X axis is 2 minutes and 30 seconds, and it has 

been changed from 0 second at the start of the strip chart.  
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Tracking Multiple Wavelengths on a Single Strip Chart 

By pressing the Add button from the Strip Chart Settings window, it is possible to display 

multiple wavelengths. Here, spectrum intensity at 485.94 nm and 655.91 nm are 

displayed. See the following figure: 

 

Figure 7-8: Tracking multiple wavelengths on a single strip chart 

 

Note:  When two or more waveforms are displayed, the second curve may not be 

displayed. This is because the Y axis is adjusted to the scale of the first curve. In 

this case, press the "Scale graph automatically" button on the tool bar to display 

both curves at the same time as shown above. 

You can also mark the original spectrum if necessary (see "Placing Marks on the Graph"). 

The figure below shows the two wavelengths intensities tracked by the strip chart. 
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Figure 7-9: Multiple wavelengths marked on spectrum with the intensity displayed 

 

Graph Toolbar Buttons 

In the graph toolbar buttons at the top of the graph, you can adjust the scale of the graph, 

save the graph, print a strip chart, etc. (the place marked with the red border). 
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Figure 7-10: The toolbar buttons of the strip chart 

Scale Adjustment Buttons 

In the graph scale adjustment, there are two differences in the strip chart and spectrum 

diagram. First, the strip chart has a unique button that can temporarily freeze the chart 

(the Strip Chart View button). Second, the Scale X-axis automatically button. The other 

functions are the same as the spectrum diagram. 

Strip Chart View 

 

Figure 7-11: The Strip Chart View button 

 

This button allows you to freeze the strip chart. As the strip chart emulates the action of a 
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physical strip of paper recording continuous data from left to right, the graph will scroll to 

the left as it charts new data at end of the graph. Pressing this button temporarily freezes 

the scrolling so that you can examine the data closely. When you are finished, you can 

press the button again to unfreeze it. Freezing the strip chart will not stop it from 

capturing new data. The software will keep recording new data in the background, so you 

will see continuous data when you unfreeze the chart. 

A strip chart has two states ("active" and "inactive"), which you can tell from the 

appearance of this button. When a strip chart is active, this button has a blue border 

around it. When the strip chart is inactive, it lacks the border. See the following figure: 

 

Figure 7-12: The "active" and "inactive" states of the Strip Chart View button 
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Time Period for Data Display (X-axis) 

 

Figure 7-13: The control for modifying the time period for data display 

 

Here, you specify the width of the strip chart display time. The default display time width 

is 10 minutes. The example in the figure has been changed to 30 minutes. The display 

time can be set to the elapsed time (delta time) from the start of acquisition, the number 

of data from the acquisition start (delta data), and the time (min, hour, day). 

 

Figure 7-14: Changing the time period for data display to thirty minutes 
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Record Setting Buttons 

In addition, the graph toolbar at the top of the graph has a button for recording setting 

(marked with a red border). 

 

 

Figure 7-15: Record Setting toolbar button above strip chart. 

 

Record 

 

    

Figure 7-16: When Record button (left) is pressed, record starts. When record is in progress, the Record button is not active. 
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When you press the Record button, the previously recorded data will be erased and new 

data will be recorded. The previous graph on the Strip Chart's window will be erased and 

new graph will started 

 

Stop 

    

Figure 7-17: Stop button, when the record is in progress, Stop button is active.  

Press the Stop button to stop the record.  

 

 

Record Setting 

  

Figure 7-18: Record Setting button 

By pressing the Record Setting button, the Record Setting window showed in Figure 7-4 

will be displayed, and you can change the record conditions.   

 

Save Record 

    

Figure 7-19: Save Record button 

Records can be saved when the button is active. 
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By pressing the Save Record button, you can save the data from Start to Stop by 

specifying the save destination.  

 

Scroll Bar State 

     

Figure 7-20: Scroll Bar State button 

The arrangement of spectrum data is ascending in case of left and descending in case of right 

Press the Scroll Bar State button to display the spectrum data frame in descending order, 

and pressing it again will be in ascending order.  

 
 

Other Easy Access Buttons 

Other toolbar buttons work exactly the in same way they do for the spectrum 

measurement. For details, refer to "Other Easy Access Buttons" in the chapter of 

spectrum measurement. 

Saving a Strip Chart 

Saving a strip chart follows a similar procedure for saving a spectrum measurement. For 

details, refer to "Saving the Current Spectrum Measurement" in the chapter of spectrum 

measurement. 

Loading Saved Strip Chart 

If you need to load a previously saved strip chart curve, you can follow the same steps for 

loading a saved spectrum curve. For details, refer to "Loading Saved Spectrum Curve" in 

the chapter of spectrum measurement. 

Deleting Individual Strip Chart Curves 

When you have multiple curves on the same strip chart, you might want to delete one of 
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them. You delete individual strip chart curves in the same way you delete spectrum 

curves. For details, refer to "Deleting Individual Spectrum Curves" in the chapter of 

spectrum measurement. 

Printing and Previewing a Strip Chart 

The steps for printing and previewing a strip chart are the same as in printing and 

previewing a spectrum measurement. For details, refer to "Printing and Previewing a 

Spectrum Measurement" in the chapter of spectrum measurement. 
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8. Absorbance Measurement 

Absorbance is calculated from the spectrum of the light source and the spectrum of light 

passing through the object to be measured. Therefore, to measure the absorbance, first 

measure the spectrum of the light source, then set the object to be measured and 

measure the light that passed through the object. When the measurement is completed, 

the program automatically calculates the absorbance spectrum. 

Creating an Absorbance Measurement 

For the measurement of the absorbance, select Absorbance from the Measurement 

menu and open the New Absorbance Measurement window, as shown below: 

 

Figure 8-1: Selecting Absorbance from the Measurement menu to create a new absorbance measurement 

 

Then, you will see the following window: 
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Figure 8-2: New Absorbance Measurement - Source Device 

 

Selecting a Source Device 

On the Source Device window, please select a source device (identified by its serial 

number). Then, click Next. 
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Figure 8-3: New Absorbance Measurement - Acquisition Parameters 

 

Specifying Integration Time 

Then specify the integration time (sensor exposure time) on the Acquisition Parameters 

window. In the program, the default integration time is set automatically when the 

window is opened. Adjust the integration time while referring to the preview at the 

bottom of the screen as necessary. The preview will change as you adjusted, so set the 

peak value within the Suggested peak value range on the window. In the example, the 

peak value is set within the range of 40000-60000. 

If the adjustment is not successful, you can press the Auto Configuration button to have 

the program automatically recovered to default setting.  

 

After setting the integration time, set the spectrum scanning interval if you need. Press 

Spectrum Scanning Interval, select Enable user-defined spectrum scanning interval, and 
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then specify the interval you want (the default is 500ms), as in the following: 

 

Figure 8-4: Spectrum Scanning Interval 

 

Smoothing 

In addition to the integration time and the scanning interval, you can also choose 

whether to smooth out the curve. Specify the number of scans to calculate the average 

value for "Average count". This makes it possible to reduce curvature fluctuation more 

than a single data acquisition. In the Boxcar width, specify the number of data used for 

moving average calculation. This smooths out the sharp variations on the curve: the 

bigger the Boxcar width of, the smoother the curve. The following figure demonstrates 

the smoothing effect when Boxcar width is 10 (maximum value). Compare it with the 

original Figure 8-3 without smoothing. 
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Figure 8-5: New Absorbance Measurement - the smoothing effect 

 

Note: The following example uses the default settings, i.e. no smoothing (Number of 

scans to average=1, Boxcar width=0). 

When all acquisition parameters are set, click Next. 
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Figure 8-6: New Absorbance Measurement - Reference Spectrum 

 

Setting Reference Spectrum 

Next, you need to set a "reference spectrum," which is basically the spectrum of the light 

source before set the test object in place. Here, you can click on the color patch on the 

window to acquire the live spectrum as the reference. Or, if you previously saved the 

reference spectrum file you can read it using the Browse button. In this example, the 

current light source is being read as a reference spectrum (as such, please don't put the 

test object in place). Once the reference spectrum is captured, you can check the spectral 

data in the preview at the bottom of the screen. Then press Next. 
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Figure 8-7: New Absorbance Measurement - Dark Spectrum 

 

Setting Dark Spectrum 

After setting the reference spectrum, set the measurement value when light sensor is not 

exposed to light to establish a baseline, i.e. the "dark spectrum." So, please cut off or 

block the light source connected to the spectrometer. Then, click on the black-and-white 

patch on the window to acquire the dark spectrum. It is possible to calculate and set the 

average value by multiple acquisitions rather than one acquisition. For the example 10 is 

used, instead of the default 1. Once the dark spectrum is acquired, you can check the 

spectrum graph on the lower half of the window, as in the former figure. In addition, you 

will see an "Acquiring dark spectrum..." message window. See the following figure: 

 

Figure 8-8: Acquiring dark spectrum... 

 

https://www.als-japan.com/


SpectraSmart User's Guide 8. Absorbance Measurement 

  
https://www.als-japan.com/      92 

 

Other than actually acquired dark spectrum, it is also possible to use the default dark 

spectrum, or to use a previously saved dark spectrum file. The default dark spectrum is 

for test purposes only, please be carefully when using. The following figure shows the 

case when Use default dark spectrum is selected. 

 

Figure 8-9: New Absorbance Measurement - Using the default dark spectrum 

 

Note:  This example uses the dark spectrum captured in real-time (not the default dark 

spectrum). 

Once the dark spectrum is set, click Next. 
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Figure 8-10: New Absorbance Measurement - Display Settings 

 

Display Settings 

Next, you can specify a name for the measurement graph window, as well as a spectrum 

title and a color for the graph, as in the former figure. To specify the color, you can click 

on the color patch and select the desired color from the palette: 

https://www.als-japan.com/


SpectraSmart User's Guide 8. Absorbance Measurement 

  
https://www.als-japan.com/      94 

 

 

Figure 8-11: Display Settings – Color 

 

When you finish setting the display, click OK. The measurement graph is displayed as 

shown below. 

 

Figure 8-12: Newly created absorbance measurement graph 
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Start Measuring the Absorbance of the Test Object 

After setting the absorbance measurement graph, set the objet to be measured. Here we 

measure the absorbance curve of a white transparent filter for demonstration. Its 

absorbance measurement graph looks like the following: 

 

Figure 8-13: The absorbance graph of a white transparent filter 

 

As shown in the above figure, the white transparent filter absorbs light of all visible 

wavelengths, and absorption was observed over a wavelength in general. 

When placing a blue transparent filter, the absorbance in the blue wavelength range of 

the spectrum becomes lower than the absorbance in the other wavelength range 

(meaning that more blue light passes through the filter) as shown in the figure. 

https://www.als-japan.com/


SpectraSmart User's Guide 8. Absorbance Measurement 

  
https://www.als-japan.com/      96 

 

 

 Figure 8-14: The absorbance graph of a blue transparent filter 

 

Checking the Acquired Spectrum Curve 

The absorbance curve is calculated from multiple spectrums. SpectraSmart has a function 

to examine the original spectrum curve. This function is activated clicking the Acquired 

Spectrum button on the toolbar, as shown in the following figure. 

 

Figure 8-15: The Acquired Spectrum button 

 

The following three figures show the absorbance graphs with their acquired spectrums 

for the original light source, the white transparent filter, and the blue transparent filter, 

respectively: 
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Figure 8-16: The acquired spectrum of the absorbance measurement for the original light source 

 

 

Figure 8-17: The acquired spectrum of the absorbance measurement for the white transparent filter 
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Figure 8-18: The acquired spectrum of the absorbance measurement for the blue transparent filter 

 

From the above figure, it can be seen that the curve of the white transparent filter 

dropped significantly compared to the curve of the light source. The lowered part is the 

amount of light absorbed by the filter. In the curve of the blue transparent filter, the blue 

visible region remains, and almost all the light in the other wavelength region is 

absorbed. 

Graph Toolbar Buttons 

The toolbar button of the absorbance measurement graph is almost the same as the 

toolbar of the spectrum measurement graph. 

Smoothing 

In the absorbance measurement, Smoothing is often used. For example, you can see a 

large jaggy in the absorbance curve of the previous blue transparent filter. If you apply 

smoothing with the Smoothing button at the top of the graph this jaggedness will be 

improved. 
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Figure 8-19: The Smoothing Settings window 

 

Here we enable the Savitzky-Golay filter and select 11 points for the smoothing Degree. 

Then, click OK to see its effect: 

 

Figure 8-20: Enabling Smoothing effect for the absorbance graph of the blue transparent filter 

 

As the figure shows, smoothing has made the curve more continuous and smoother. 
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Measurement Mode Switching Buttons 

In addition to the toolbar buttons described in the chapter of spectrum measurement, 

the absorbance, transmittance, and reflectance measurements all have a set of 

measurement mode switching buttons: 

 

Figure 8-21: Measurement mode switching buttons 

 

When measuring absorbance, transmittance, and reflectance, SpectraSmart allows you to 

switch among four measurement modes: S (spectrum), A (absorbance), T (transmittance), 

and R (reflectance). Therefore, this set of buttons is available on the toolbar of these 

three measurement graphs. The following four figures show the absorbance graphs of the 

blue filter glass in four different modes (S, A, T, R), respectively: 

 

 

Figure 8-22: Mode switching - S (spectrum) mode button 
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Figure 8-23: Mode switching - A (absorbance) mode button 

 

 

Figure 8-24: Mode switching - T (transmittance) mode button 
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Figure 8-25: Mode switching - R (reflectance) mode button 

 

S (spectrum) mode graph corresponds to the "acquired spectrum" of the absorbance 

measurement. Since we are using the blue transparent filter as an example, the blue 

lights of the spectrum becomes particularly strong. On the other hand, T (transmittance) 

and R (reflectance) modes are opposite of the absorbance. This is because the 

absorbance mode measures the amount of light absorbed by the filter, while the 

transmittance mode measures the amount light pass through the filter. Furthermore, the 

reflectance curve and the transmittance curve look very similar, the reflectance mode 

measures the light reflected from the test object, it virtually equals to the remaining light 

after being absorbed by the test object. 

Setting a New Reference Spectrum or Dark Spectrum 

In some cases, it may be necessary to set a new reference spectrum or a new dark 

spectrum during the measurement. Even without the re-measuring, you can reset the 

reference and dark spectrum on the toolbar button provided in the SpectraSmart. See the 

following figure: 
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Figure 8-26: Set as reference spectrum and Set as dark spectrum buttons 

 

Switch the current reference light source to the new light source, and then press Set as 

reference spectrum. The spectrum captured from the new light source will now be the 

new reference spectrum. Similarly, you can simply block the current light source or switch 

to another light source as the baseline, and then press Set as dark spectrum to capture 

and set the new dark spectrum. 

Basically, whenever a measurement needs a reference spectrum to work, the Set as 

reference spectrum button will appear on the toolbar. This includes measurements for 

absorbance, transmittance, reflectance, and concentration. If you can reset the dark 

spectrum as well, the Set as dark spectrum button on the toolbar will be displayed 

automatically. This is the same for transmittance, absorption rate, reflectance, and 

concentration measurement. 

Saving Absorbance Measurement 

Saving an absorbance measurement is similar to saving a spectrum measurement, except 

that the spectrum measurement only one spectrum curve is saved, while for the 

absorbance measurement, four spectrum curves: reference spectrum, dark spectrum, 

absorbance curve, and the acquired spectrum are saved. 

Using the Save selected spectrum as, on the toolbar button, only one spectrum curve is 

saved at a time. To save all the spectrum curves in a measurement, you need to use the 

Save all spectrums in option in the pop-up menu of the spectrum data frame. Once saved, 

you will see all four spectrum curves in the specific folder. 
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Figure 8-27: Saving all spectrums in an absorbance measurement using the Save all spectrums in option 

 

For more details, please refer to "Saving the Current Spectrum Measurement" in the 

chapter of spectrum measurement. 

Loading Saved Spectrum Curve of an Absorbance Measurement 

In order to read the previously saved absorbance spectrum, you can only read one 

spectrum curve at a time just like "Loading Saved Spectrum Curve". For details, refer to 

"Loading Saved Spectrum Curve" of spectrum measurement. 

Deleting Individual Spectrum Curves of an Absorbance 

Measurement 

An absorbance measurement is composed of multiple spectrum curves. As such, please 

don't delete any individual curve from the measurement as they function as one. Doing 

so will destroy the entire measurement. 

Printing and Previewing an Absorbance Measurement 

The method of printing and previewing a absorbance measurement is the same as the 

spectrum measurement. Please refer to "Printing and Previewing a Spectrum 

Measurement" in the chapter of spectrum measurement. 
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9. Transmittance Measurement 

The transmittance is calculated from the spectrum of the light source and the spectrum 

after it has passed through the object to be measured. Therefore, similarly to the 

measurement of absorbance, in order to measure the transmittance, first measure the 

spectrum of the light source, then measure the light transmitted through the object to be 

measured. When the measurement is completed, the program automatically calculates 

the transmittance spectrum. 

Creating a Transmittance Measurement 

For the transmittance measurement, select Transmittance from the Measurement menu 

and open the New Transmittance Measurement window, as shown below. 

 

Figure 9-1: Select Transmittance from the Measurement menu and open a new transmittance measurement 

 

Then, you will see the following window: 
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Figure 9-2: New Transmittance Measurement - Source Device 

 

Selecting the Source Device 

First, select the source device (identified by the device serial number) on the Source 

Device window. Then, click Next. 
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Figure 9-3: New Transmittance Measurement - Color Parameters 

 

Setting Color Parameters 

For transmittance measurement, specify the viewing angle of CIE Standard Observer 

(Observer angle) and the type of light source (Illuminant) for accurate color 

measurement. SpectraSmart supports two standard observer viewing angles: 2-degree 

and 10-degree (corresponding to CIE 1931 and CIE 1964 standards, respectively), and 

number of standard light sources. In this example, two viewing angles and a D65 light 

source are specified. After finishing the select, click Next. 
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Figure 9-4: New Transmittance Measurement - Acquisition Parameters 

 

Specifying Integration Time 

Then specify the integration time (i.e. the exposure time for the light sensor) on the 

Acquisition Parameters window. In the program, the default integration time is set 

automatically when the window is opened. Adjust the integration time while referring to 

the preview at the bottom of the screen as necessary. The preview will change as you 

adjusted, so set the peak value within the Suggested peak value range on the window. In 

the example, the peak value is set within the range of 40000-60000. 
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If the adjustment is not successful, you can press the Auto Configuration button to have 

the program automatically recovered to default setting. After setting the integration time, 

set the interval of the spectrum scan as necessary. Click the Scanning Interval button, 

then on the Spectrum Scanning Interval window, select Enable user-defined spectrum 

scanning interval, and specify the interval required (the default is 500 ms), as in the 

following: 

 

Figure 9-5: Spectrum Scanning Interval 

 

Smoothing 

Smoothing processing can be performed on the spectrum curve. Specify the number of 

scans to calculate the average value for "Number of scans to average". This makes 

possible to reduce the fluctuation of the curve even for only one acquisition data. For 

Boxcar Width, specify the number of data points on both side of the point of interest to 

include in the calculation of the moving average. This can reduce the sudden change of 

the curve. This smooths out the sharp variations on the curve: the bigger the Boxcar 

width, the smoother the curve. The following figure demonstrates the smoothing effect 

of a Boxcar width of 10 (maximum value). You can compare it with the former curve 

without smoothing to see the difference (see the red curve in the preview graph). 
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Figure 9-6: New Transmittance Measurement - the smoothing effect 

 

When all acquisition parameters are set, click Next. 
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Figure 9-7: New Transmittance Measurement - Reference Spectrum 

 

Setting Reference Spectrum 

Set the light source spectrum where the object to be measured is not placed, that is, 

"reference spectrum". Here, you can click on the color patch on the window to acquire 

the live spectrum as the reference spectrum. Or, you can use the Browse button to load a 

previous reference spectrum file. In this example, we use the default option, that is 

acquiring the current live spectrum of the light source (as such, please don't put the test 

object in place). Once the reference spectrum is captured, you will see it in the preview 

graph on the lower half of this window. Then, click Next. 
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Figure 9-8: New Transmittance Measurement - Dark Spectrum 

 

Setting Dark Spectrum 

After setting the reference spectrum, set the measurement value when light does not hit 

the sensor, ie "dark spectrum". So, please cut off or block the light source connected to 

the spectrometer. Then, click on the black-and-white patch on the window to acquire the 

dark spectrum. It is possible to calculate and set the average value by multiple acquisition 

rather than one acquisition. The default is 1 time. For the example is 10 times. After 

acquiring the dark spectrum, you can check the spectrum acquired in the preview at the 

bottom of the screen. In addition, you will see an "Acquiring dark spectrum..." message 

window. See the following figure: 

 

Figure 9-9: Acquiring dark spectrum... 

In addition to capture the dark spectrum in real time, it is possible to select the program's 
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default dark spectrum or load a previous dark spectrum file. Please note that the default 

dark spectrum is a set of built-in data which is handy for testing purposes. It may not be 

suitable for your current measurement environment. The following figure shows the case 

when you choose to Use default dark spectrum: 

 

Figure 9-10: New Transmittance Measurement - Using the default dark spectrum 

 

Note:  This example uses the dark spectrum captured in real-time (not the default dark 

spectrum). 

Once the dark spectrum is set, click Next. 
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Figure 9-11: New Transmittance Measurement - Display Settings 

 

Display Settings 

Next, you can specify a name for the measurement graph window, as well as a spectrum 

title and a color for the graph, as in the former figure. To specify the color, you can click 

on the color patch and select the desired color from the palette: 
 

https://www.als-japan.com/


SpectraSmart User's Guide 9. Transmittance Measurement 

  
https://www.als-japan.com/      115 

 

 

Figure 9-12: Display Settings - Color 

 

When you finish setting the display, click OK. The measurement graph is displayed as 

shown below. 

 

Figure 9-13: Newly created transmittance measurement graph  
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In the figure above, the transmittance is almost 100% in the entire visible range because 

the object to be measured is not set. As a reference light source, a deuterium halogen 

light source of 200 to 1700 nm is used, and by adjusting the display range of the graph to 

380 to 780 nm, it is possible to make the graph in the visible region easier to view (see 

"Graph Settings" for details). The adjusted graph is shown below: 

 

Figure 9-14: Transmittance measurement graph with adjusted wavelength range in the visible region 

 

Start Measuring the Transmittance of the Test Object 

Next, set the object to be measured and measure the transmittance. The transmittance 

result of a white transparent filter is shown in the figure below. 
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Figure 9-15: The transmittance graph of a white transparent filter 

 

As shown above, the white transparent filter absorbs light of all visible wavelengths, so 

the transmittance decreases throughout the wavelength. In the case of a blue transparent 

filter, the transmittance of the blue visible light portion becomes high as shown in the 

figure below. 

 

Figure 9-16: The transmittance graph of a blue transparent filter 
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Checking the Acquired Spectrum Curve 

The transmittance curve is calculated from multiple spectra. Spectra smart has the 

function of examining the original spectral curve in order to check whether the measured 

value is correct or not. You can activate this function by pressing the Acquired Spectrum 

button on the toolbar. 

 

Figure 9-17: The Acquired Spectrum button 

 

The following three figures show the transmittance graphs with their acquired spectrums 

for the original light source, the white transparent filter, and the blue transparent filter, 

respectively: 

 

Figure 9-18: The acquired spectrum of the transmittance measurement for the original light source 
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Figure 9-19: The acquired spectrum of the transmittance measurement for the white transparent filter 

 

 

Figure 9-20: The acquired spectrum of the transmittance measurement for the blue transparent filter 

 

From the above figure, it can be seen that the spectrum curve of the white transparent 

filter transmits all wavelengths in visible light. It can be seen that the spectrum curve of 

the blue transparent filter passes most blue visible light. 
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Checking Colorimetry Information 

In the measurement of transmittance, reflectance and emission intensity, it is possible to 

investigate not only the spectrum but also color information. When you press the vertical 

Colorimetry button on the right side of the spectrum data window, the Colorimetry 

screen opens. 

 

Figure 9-21: The Colorimetry button and the Colorimetry pane 

 

As in the figure above, this window shows details about the Acquired Spectrum, including 

standard observer's viewing angle, illuminant, CIE X, Y, Z coordinates, etc. 

Colorimetry Toolbar Buttons 

Save, Save Log, Interval, Reset Log, and Show Strip Chart are displayed on the toolbar 

butto of the Colorimetry window. 

 

Figure 9-22: Colorimetry toolbar buttons 
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These buttons functions are explained below. 

1. Save: Save the current colorimetry information as a text (CSV) file. Its content is 

exactly like what you see in the previous figure. 

2. Save Log: This button allows you to keep track of colorimetry changes over a 

period of time by saving SpectraSmart's internal log of accumulated colorimetry 

data to a file. 

3. Interval: This setting allows you to set the update interval for the colorimetry 

information. 

4. Reset Log: The currently accumulated internal data is deleted and new recording 

is started. When you want to record the colorimetry changes over a period of time, 

first clear the internal log by using the Reset Log button, and then, press the Save 

Log button after the measurement is completed, the data is saved as test file. 

5. Show Strip Chart: This button allows you to keep track of a single colorimetry 

value and see its changes over time. For example, to display the change in X value, 

select "X" and press the Show Strip Chart button to show a pop-up window with a 

strip chart that tracks the changes of this value over time. See the figure below:  
 

 

Figure 9-23: The strip chart for tracking colorimetry information 
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Comparing Colorimetry Information  

 

Figure 9-24: Comparing colorimetry information 

 

When the color Comparison function is used, the difference between the current 

measured value and the standard value entered for comparison is displayed.  

Note:  In the comparison table, if you enter a numerical value in the Standard field, the 

difference will be calculated automatically. 

Checking Diagrams 

In addition to colorimetry information, SpectraSmart also provides diagrams for the user 

to check the color coordinates and the dominant wavelength of the test object. Press the 

CIE Diagram button along the right edge of the measurement graph to enable this feature. 

See the figure below: 

 

Figure 9-25: The CIE Diagram button and the CIE Diagram pane 
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Switching Colorimetry Diagrams 

SpectraSmart provides four types CIE diagrams: CIE 1931 ,CIE 1976, TM 30-15 RfRg and 

TM 30-15 Color Vector Graphic. You can switch between them by clicking the respective 

tab. 

 

Figure 9-26: CIE 1931,CIE 1976, TM 30-15 Rf & Rg and TM 30-15 Color Vector Graphic diagram switching tabs 

 

 

Figure 9-27: The CIE 1976 diagram 

 

CIE Diagram Toolbar Buttons 

The CIE 1931 diagram provides a toolbar with a few function buttons: Save as image, 

Print Preview, Print, and CCT Quad, as shown in the following: 
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Figure 9-28: The CIE Diagram toolbar 

 

Saving Colorimetry diagram 

The Save as image button saves the currently displayed CIE diagram to an image file. 

Pressing this button shows a standard Save As window. Specify the destination folder and 

the filename, and then press Save to save the file. See the following: 

 

Figure 9-29: Pressing Save as image opens the Save As window 
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Printing Colorimetry Diagram 

The Print Preview and Print buttons allow you to preview and print the currently 

displayed diagram. When pressed, they show the standard Print Preview and Print 

dialogs, respectively. 

CCT Quad 

The CCT Quad button allows you to show correlated color temperature (CCT) lines on the 

CIE 1931 diagram (not applicable to the CIE 1976 diagram), as shown in the following: 

 

Figure 9-30: Showing correlated color temperature (CCT) lines on the CIE diagram 

Graph Toolbar Buttons 

Calculated Color Range 

When the user only wants to observe a particular color range, instead of the entire visible 

spectrum, by measuring transmittance, reflectance and emission intensity, Calculated 

Color Range button, can be used to specify the wavelength range. 

 

Figure 9-31: The Calculated Color Range button  
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Select Limit the wavelength range for color calculation, and then specifies the range in 

Wavelength range, as shown below. 

 

Figure 9-32: Specifying Calculated Color Range 

In the example, the range from 400 nm to 500 nm is setting. Pressing OK, the 

measurement graph will display only the curve within the specified range. 
 

 

Figure 9-33: The effect of specifying calculated color range 

 

Except for the Calculated Color Range button, the toolbar button of the transmittance 

measurement graph is almost the same as the absorbance measurement graph. Please 

refer to "Graph Toolbar Buttons" in the chapter of absorbance measurement. 

Saving Transmittance Measurement 

The method of saving the transmittance measurement is the same as saving the 

absorbance measurement. Please refer to "Saving Absorbance Measurement" in the 
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chapter of absorbance measurement. 

Loading Saved Transmittance Measurement Spectrum Curve 

The method of loading the saved transmittance measurement spectrum curve is almost 

the same as the absorbance measurement. However, when loading the transmittance 

measurement spectrum curve, select whether or not calculate the colorimetry 

information. 

 

Figure 9-34: Choosing Calculate colorimetry information when loading of the transmittance measurement 

spectrum curve 

 

As the former figure shows, after selecting Calculate colorimetry information, you need 

to specify Observer angle and Illuminant next. With this information provided, you will 

be able to see corresponding data in the Colorimetry and Diagram panes. Apart from this 

difference, all other details are identical to loading a spectrum curve of an absorbance 

measurement. Please refer to "Loading Saved Spectrum Curve of an Absorbance 

Measurement" in the chapter of absorbance measurement. 
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Deleting Individual of Transmittance Measurement Spectrum Curves 

The result of the transmittance measurement is calculated form multiple spectrum curves. 

Therefore, please do not delete any of the curves. If one of the curves is deleted, the 

result is not calculated correctly. 

Printing and Previewing Transmittance Measurement Spectrum 

The steps for printing and previewing transmittance measurement spectrum are the 

same as in printing and previewing spectrum measurement. Please refer to "Printing and 

Previewing a Spectrum Measurement" in the chapter of spectrum measurement. 
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10. Reflectance Measurement 

Reflectance is calculated from the spectrum of the light source and the spectrum 

reflected on the object to be measured. Therefore, similarly to the measurement of 

absorbance, in order to measure the reflectance, first measure the spectrum of the light 

source and then measure the light reflected on the object to be measured. When the 

measurement is completed, the program automatically calculates the reflectance 

spectrum. 

Reflectance measurement setting 

For reflectance measurement, select Reflectance from the Measurement menu to open 

the New Reflectance Measurement window, as shown below. 

 

Figure 10-1: Selecting Reflectance from the Measurement menu to open the new reflectance measurement 

 

Then, you will see the following window: 
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Figure 10-2: New Reflectance Measurement - Source Device 

 

Selecting a Source Device 

On the Source Device window, please select a source device (identified by its serial 

number). Then, click Next. 
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Figure 10-3: New Reflectance Measurement - Color Parameters 

 

Setting Color Parameters 

For reflectance measurement, specify the viewing angle of CIE standard observer and the 

type of light source. It corresponds to viewing angle of 2 degrees and 10 degrees 

(corresponding to CIE 1931 and CIE 1964 respectively) and multiple standard light sources.  

Here we choose 2-degree and D65, and then click Next. 

Specifying Standard White Reflectance 

For reflectance measurement, you can enter the standard white reflection coefficient by 

inserting a white calibration file. When the standard white reflection coefficient is not 

input, the standard white board is calculated as 100% total reflection, not the actual 

reflectance of the object to be measured. By inputting the standard white reflection 

coefficient, absolute reflectance of the object to be measured can be calculated. 

To specify a white calibration file, click on the Browse button and navigate to your white 

calibration file. After it is specified, you will see the white calibration curve in the preview 

chart. See the following figure: 
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Figure 10-4: New Reflectance Measurement - White Calibration 

 

The following figure shows the format of a white calibration file. The first field represents 

the wavelength, and the second field represents the reflectance. 

 

Figure 10-5: The format of a white calibration file 

 

Note: The default setting (i.e. no white calibration file) is used in our following 

example. 
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Figure 10-6: New Reflectance Measurement - Acquisition Parameters 

 

Specifying Integration Time 

Then specify the integration time (i.e. the exposure time for the light sensor) on the 

Acquisition Parameters window. In the program, the default integration time is set 

automatically when the window is opened. Adjust the integration time while referring to 

the preview at the bottom of the screen as necessary. The preview will change as you 

adjusted, so set the peak value within the Suggested peak value range on the window. In 

the example, the peak value is set within the range of 40000-60000. 

If the adjustment is not successful, you can press the Auto Configuration button to have 

the program automatically recovered to default setting.  

Once the integration time is set, you can continue to set the spectrum scanning interval if 

you need. Please click the Scanning Interval button. On the Spectrum Scanning Interval 

window, select Enable user-defined spectrum scanning interval, and then specify the 
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interval you want (the default is 500 ms), as in the following figure: 

 

Figure 10-7: Spectrum Scanning Interval 

 

Smoothing 

Smoothing processing can be performed on the spectrum curve. Specify the number of 

scans to calculate the average value for "Number of scans to average". This makes 

possible to reduce the fluctuation of the curve even for only one acquisition data. For 

Boxcar Width, specify the number of data points on both side of the point of interest to 

include in the calculation of the moving average. This can reduce the sudden change of 

the curve. This smooths out the sharp variations on the curve: the bigger the Boxcar 

width, the smoother the curve. The following figure demonstrates the smoothing effect 

of a Boxcar width of 10 (maximum value). You can compare it with the former curve 

without smoothing to see the difference (see the red curve in the preview graph). 
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Figure 10-8: New Reflectance Measurement - the smoothing effect 

 

Note:  The following example uses the default settings, i.e. no smoothing (Number of 

scans to average=1, Boxcar width=0). 

When all acquisition parameters have been set, click Next. 
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Figure 10-9: New Reflectance Measurement - Reference Spectrum 

 

Setting Reference Spectrum 

Set the light source spectrum where the object to be measured is not placed, that is, 

"reference spectrum". Here, you can click on the color patch on the window to acquire 

the live spectrum as the reference spectrum. Or, you can use the Browse button to load a 

previous reference spectrum file. In this example, we use the default option, that is 

acquiring the current live spectrum of the light source (as such, please don't put the test 

object in place). Once the reference spectrum is captured, you will see it in the preview 

graph on the lower half of this window. Then, click Next. 
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Figure 10-10: New Reflectance Measurement - Dark Spectrum 

 

Setting Dark Spectrum 

After setting the reference spectrum, set the measurement value when light does not hit 

the sensor, ie "dark spectrum". So, please cut off or block the light source connected to 

the spectrometer. Then, click on the black-and-white patch on the window to acquire the 

dark spectrum. It is possible to calculate and set the average value by multiple acquisition 

rather than one acquisition. The default is 1 time. For the example is 10 times. After 

acquiring the dark spectrum, you can check the spectrum acquired in the preview at the 

bottom of the screen. In addition, you will see an "Acquiring dark spectrum..." message 

window. See the following figure: 
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Figure 10-11: Acquiring dark spectrum... 

 

In addition to capture the dark spectrum in real time, it is possible to select the program's 

default dark spectrum or load a previous dark spectrum file. Please note that the default 

dark spectrum is a set of built-in data which is handy for testing purposes. It may not be 

suitable for your current measurement environment. The following figure shows the case 

when you choose to Use default dark spectrum: 

 

Figure 10-12: New Reflectance Measurement - Using the default dark spectrum 

 

Note:  This example uses the dark spectrum captured in real-time (not the default dark 

spectrum). 

Once the dark spectrum is set, click Next. 
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Figure 10-13: New Reflectance Measurement - Display Settings 

 

Display Settings 

Next, you can specify a name for the measurement graph window, as well as a spectrum 

title and a color for the graph, as in the former figure. To specify the color, you can click 

on the color patch and select the desired color from the palette: 
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Figure 10-14: Display Settings – Color 

 

When you finished the display settings, click OK, and then SpectraSmart will display the 

measurement graph, as shown below: 

 

Figure 10-15: Newly created reflectance measurement graph 

 

Since the object to be measured has not been set yet, the reflectance in the visible range 

is almost zero. Furthermore, since the reference light source is a halogen light source, its 

wavelength range is approximately 400 nm or more, and adjusting the display range to 

400 to 780 nm makes the graph easier to see (see "Graph Settings" for details). The 
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adjusted graph looks like the following: 

 

Figure 10-16: Reflectance measurement graph adjusted to the wavelength range 
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Start Measuring the Reflectance of the Test Object 

Next, set the test object to measure the reflectance. Here silver metal sheet reflectance 

was measured for demonstration. The result is shown below: 

 

Figure 10-17: The reflectance measurement graph of a silver metal plate 

 

In the figure, because the silver metal sheet reflects light over all visible wavelengths, the 

curve has the full range of visible light. 

Subsequently, when it is changed to a silver-blue metal sheet, its reflectance curve is 

measured, the reflectance of blue visible light is still high as shown below, and the 

reflectance of yellow light to red light is low. 

https://www.als-japan.com/


SpectraSmart User's Guide 10. Reflectance Measurement 

  
https://www.als-japan.com/      143 

 

 

Figure 10-18: The reflectance measurement graph of a silver-blue metal sheet 

 

Checking the Acquired Spectrum Curve 

Since the reflectance curve is calculated based on the spectrum acquired by the software, 

SpectraSmart provides a feature for the user to see the original acquired spectrum curve 

so it can be verified against the reflectance curve. Click on the Acquired Spectrum button 

on the toolbar to enable this feature, as shown in the following figure: 

 

Figure 10-19: The Acquired Spectrum button 

 

The following three figures show the reflectance graphs with their acquired spectrums for 

the original light source, the silver metal sheet, and the silver-blue metal sheet, 

respectively: 
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Figure 10-20: Reflectance measurement light source acquired spectrum when the objet to be measured is not set 

 

 

Figure 10-21: Reflectance measurement acquired spectrum for the silver metal sheet 
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Figure 10-22: The acquired spectrum of the reflectance measurement for the silver-blue metal sheet 

 

As we can see in the figures above, the silver metal sheet reflects most of the visible light, 

while the silver-blue metal sheet mainly reflects the red light. 

Checking Colorimetry Information 

When measuring transmittance, reflectance, and emission intensity, SpectraSmart also 

provides colorimetry information in addition to the measurement graph and the Acquired 

Spectrum. Please refer to "Checking Colorimetry Information" in the chapter of 

transmittance measurement. 

Checking Diagrams 

In addition to colorimetry information, SpectraSmart also provides diagrams for the user 

to check the color coordinates and the dominant wavelength of the test object. Please 

refer to "Checking Diagrams" in the chapter of transmittance measurement. 

Graph Toolbar Buttons 

The toolbar buttons above the reflectance measurement graph are identical to those on 

the transmittance measurement graph, and they work the same way, so we will not 

repeat the details here. Please refer to "Graph Toolbar Buttons" in the chapter of 
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transmittance measurement. 

Saving a Reflectance Measurement 

Saving a reflectance measurement follows the same steps for saving an absorbance 

measurement, so we will not repeat the details here. Please refer to "Saving Absorbance 

Measurement" in the chapter of absorbance measurement. 

Loading Saved Spectrum Curve of a Reflectance Measurement 

Loading a spectrum curve of a reflectance measurement is similar to loading that of an 

absorbance measurement, with the same limitation(s), but there is one little difference. 

When loading a spectrum curve from a reflectance measurement, the user can specify 

whether to calculate colorimetry information: 

 

Figure 10-23: Choosing Calculate colorimetry information when loading a spectrum curve of a reflectance measurement  

 

As the former figure shows, after selecting Calculate colorimetry information, you need 

to specify Observer angle and Illuminant next. With this information provided, you will 

be able to see corresponding data in the Colorimetry and CIE Diagram panes. Apart from 
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this difference, all other details are identical to loading a spectrum curve of an 

absorbance measurement. We will not repeat them here. Please refer to "Loading Saved 

Spectrum Curve of an Absorbance Measurement" in the chapter of absorbance 

measurement. 

Deleting Individual Spectrum Curves of a Reflectance Measurement 

A reflectance measurement is composed of multiple spectrum curves. As such, please 

don't delete any individual curve from the measurement as they function as one. Doing 

so will destroy the entire measurement. 

Printing and Previewing a Reflectance Measurement 

The steps for printing and previewing a reflectance measurement are the same as in 

printing and previewing a spectrum measurement. So, we will not repeat the details here. 

Please refer to "Printing and Previewing a Spectrum Measurement" in the chapter of 

spectrum measurement. 
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11. Emission Intensity Measurement 

Emission intensity measurement measures the light source directly. Therefore, there is 

not a need of the reference light source. Once the emission intensity measurement is 

carried out, the program automatically creates the light source spectrum. 

Set and measure the conditions of Emission Intensity Measurement 

For the measurement of the emission intensity, select Emission Intensity from the 

Measurement menu and open the New Emission Intensity Measurement window. 

 

Figure 11-1: Selecting Emission Intensity from the Measurement menu to create a emission intensity measurement 
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Figure 11-2: New Light Source Measurement - Source Device 

 

Selecting a Source Device 

Next, please select a source device (identified by its serial number) on the Source Device 

window. Then, click Next. 
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Figure 11-3: New Emission Intensity Measurement - Color Parameters 

 

Setting Color Parameters 

For the emission intensity measurement, specify the view angle of the CIE standard 

Observer (Observer angle) and the type of the light source (Illuminant). SpectraSmart 

supports two standard observer viewing angles: 2 degree and 10 degree (corresponding 

to CIE 1931 and CIE 1964 standards, respectively) and to multiple standard light sources. 

In this example, 2-degree and D65 are specified. When you have finished selecting it, 

press [Next]. 
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Figure 11-4: New Emission Intensity Measurement - Acquisition Parameters 

 

Specifying Integration Time 

Then specify the integration time (i.e. the exposure time for the light sensor) on the 

Acquisition Parameters window. In the program, the default integration time is set 

automatically when the window is opened. Adjust the integration time while referring to 

the preview at the bottom of the screen as necessary. The preview will change as you 

adjusted, so set the peak value within the Suggested peak value range on the window. In 

the example, the peak value is set within the range of 40000-60000. 

Note:  "Electronic Dark Correction", "Linearity Correction" and "Intensity Correction" 

are applied to the spectral display of the emission intensity measurement. For 

this reason, the intensity of the preview curve here will be obviously lower than 

those in other measurements. Therefore, when you are adjusting the acquisition 

parameters to make the highest peak fall within the suggested 40000-60000 

range, please refer to the "Current peak value" field instead of the preview chart 

on this dialog. 
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If the adjustment is not successful, you can press the Auto Configuration button to have 

the program automatically recovered to default setting.After setting the integration time, 

set the interval of the spectrum scan as necessary. Click the Scanning Interval button, 

then on the Spectrum Scanning Interval window, select Enable user-defined spectrum 

scanning interval, and specify the interval required (the default is 500 ms). 

 

Figure 11-5: Spectrum Scanning Interval 

 

Smoothing 

Smoothing processing can be performed on the spectrum curve. Specify the number of 

scans to calculate the average value for "Number of scans to average". This makes 

possible to reduce the fluctuation of the curve even for only one acquisition data. For 

Boxcar Width, specify the number of data points on both side of the point of interest to 

include in the calculation of the moving average. This can reduce the sudden change of 

the curve. This smooths out the sharp variations on the curve: the bigger the Boxcar 

width, the smoother the curve. The following figure demonstrates the smoothing effect 

of a Boxcar width of 10 (maximum value). You can compare it with the former curve 

without smoothing to see the difference (see the red curve in the preview graph). 
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Figure 11-6: New Emission Intensity Measurement - the smoothing effect 

 

Note:  The following example uses the default settings, i.e. no smoothing (Number of 

scans to average=1, Boxcar width=0). 

When all acquisition parameters are set, click Next. 
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Figure 11-7: New Emission Intensity Measurement - Dark Spectrum 

 

Setting Dark Spectrum 

Set the measurement value when light does not hit the sensor, ie "dark spectrum". So, 

please cut off or block the light source connected to the spectrometer. Then, click on the 

black-and-white patch on the window to acquire the dark spectrum. It is possible to 

calculate and set the average value by multiple acquisition rather than one acquisition. 

The default is 1 time. For the example is 10 times. After acquiring the dark spectrum, you 

can check the spectrum acquired in the preview at the bottom of the screen. In addition, 

you will see an "Acquiring dark spectrum..." message window. See the following figure: 
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Figure 11-8: Acquiring dark spectrum... 

 

In addition to capture the dark spectrum in real time, it is possible to select the program's 

default dark spectrum or load a previous dark spectrum file. Please note that the default 

dark spectrum is a set of built-in data which is handy for testing purposes. It may not be 

suitable for your current measurement environment. The following figure shows the case 

when you choose to Use default dark spectrum: 
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Figure 11-9: New Emission Intensity Measurement - Using the default dark spectrum 

 

Note:  This example uses the dark spectrum captured in real-time (not the default dark 

spectrum). 

Once the dark spectrum is set, click Next. 
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Figure 11-10: New Emission Intensity Measurement - Display Settings 

 

Display Settings 

Next, you can specify a name for the measurement graph window, as well as a spectrum 

title and a color for the graph, as in the former figure. To specify the color, you can click 

on the color patch and select the desired color from the palette: 
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Figure 11-11: Display Settings - Color 

 

When you are done with the display settings, click OK, and then SpectraSmart will display 

the measurement graph. 

Figure 11-12:  Newly created emission intensity measurement graph 

The spectrum of the measured emission intensity is shown in the figure above. Since D65 

is specified as the emission intensity during measurement conditions setting, 

SpectraSmart will automatically adjust the wavelength range (380 to 760 nm) of the 

displayed light source range. 
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Switching to Another Light Source 

An example is the result of measuring the emission intensity with red color. 
 

Figure 11-13: The measurement graph for the red light 

 

Checking the Acquired Spectrum Curve 

The emission intensity curve is calculated from multiple spectra. Spectra smart has a 

function to examine the original spectral curve. You can activate this function by clicking 

the Acquired Spectrum button on the toolbar to enable this feature. 

 

Figure 11-14: The Acquired Spectrum button 
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Figure 11-15: The acquired spectrum of the red light source measurement 

Checking Colorimetry Information 

In the measurement of transmittance, reflectance, and emission intensity, it is possible to 

investigate not only the spectrum but also provides colorimetry information. Please refer 

to "Checking Colorimetry Information" in the chapter of transmittance measurement. 

Checking Diagrams 

In addition to colorimetry information, CIE chromaticity diagram is provided to check the 

color coordinates and the dominant wavelength of the test object. Please refer to 

"Checking Diagrams" in the chapter of transmittance measurement. 

Graph Toolbar Buttons 

The toolbar buttons of the emission intensity measurement graph and spectrum graph 

are basically identical. Calculated Color Range button is added in the emission intensity 

measurement. 

 

Figure 11-16: The Calculated Color Range button  
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For details on how the Calculated Color Range button works, refer to "Graph Toolbar 

Buttons" in the chapter of transmittance measurement. For details on other toolbar 

buttons, refer to "Graph Toolbar Buttons" in the chapter of spectrum measurement. 

Saving a Emission Intensity Measurement 

Saving the current emission intensity measurement follows the same steps for saving the 

current absorbance measurement. Please refer to "Saving Absorbance Measurement" in 

the chapter of absorbance measurement. 

Loading Saved Spectrum Curve of a Emission Intensity 

Measurement 

Loading a spectrum curve of emission intensity measurement is similar to loading that of 

an absorbance measurement. When loading a spectrum curve from emission intensity 

measurement, the user can specify whether to calculate colorimetry information. 

 

Figure 11-17: Choosing Calculate colorimetry information when loading a spectrum curve 

 

As the former figure shows, after selecting Calculate colorimetry information, you need 
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to specify Observer angle and Illuminant next. With this information provided, you will 

be able to see corresponding data in the Colorimetry and CIE Diagram panes. Apart from 

this difference, all other details are identical to loading a spectrum curve of an 

absorbance measurement. We will not repeat them here. Please refer to "Loading Saved 

Spectrum Curve of an Absorbance Measurement" in the chapter of absorbance 

measurement. 

Deleting Individual Spectrum Curves of Emission Intensity 

Measurement 

A light source measurement is composed of multiple spectrum curves. As such, please 

don't delete any individual curve from the measurement as they function as one. Doing 

so will destroy the entire measurement. 

Printing and Previewing a Emission Intensity Measurement 

The steps for printing and previewing emission intensity measurement are the same as in 

printing and previewing a spectrum measurement. So, we will not repeat the details here. 

Please refer to "Printing and Previewing a Spectrum Measurement" in the chapter of 

spectrum measurement. 
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12. Concentration Measurement 

Spectrum-based concentration measurement captures the spectrum of a light source 

after it passes through the test solution, and then compares the spectrum with the light 

source's original spectrum to come up with the concentration of the solution by applying 

a known calibration table or the Beer's Law. Accordingly, as in the transmittance 

measurement, the user needs to first set up the measurement environment, measure the 

original spectrum of the light source, and then put the test solution in place and measure 

the spectrum of the light passing through the solution. SpectraSmart provides a 

straightforward procedure to measure concentration. All you have to do is follow the 

step-by-step windows to create a concentration measurement. 

Creating a Concentration Measurement 

To create a concentration measurement, please select Concentration from the 

Measurement menu to open the New Concentration Measurement window, as shown in 

the following: 

 

Figure 12-1: Selecting Concentration from the Measurement menu to create a new concentration measurement 

 

Then, you will see the following window: 
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Figure 12-2: New Concentration Measurement - Source Device 

 

Selecting a Source Device 

On the Source Device window, please select a source device (identified by its serial 

number). Then, click Next. 
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Figure 12-3: New Concentration Measurement - Acquisition Parameters 

 

Specifying Integration Time 

Then specify the integration time (i.e. the exposure time for the light sensor) on the 

Acquisition Parameters window. In the program, the default integration time set for 

absorbance measurement is set automatically when the window is opened. Adjust the 

integration time while referring to the preview at the bottom of the screen as necessary. 

The preview will change as you adjusted, so set the peak value within the Suggested peak 

value range on the window. In the example, the peak value is set within the range of 

40000-60000. 

If the adjustment is not successful, you can press the Auto Configuration button to have 

the program automatically recovered to default setting. 

Once the integration time is set, you can continue to set the spectrum scanning interval if 

you need. Please click the Scanning Interval button. On the Spectrum Scanning Interval 

window, select Enable user-defined spectrum scanning interval, and then specify the 
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interval you want (the default is 500ms), as in the following: 

 

Figure 12-4: Spectrum Scanning Interval 

 

Smoothing 

Smoothing processing can be performed on the spectrum curve. Specify the number of 

scans to calculate the average value for "Number of scans to average". This makes 

possible to reduce the fluctuation of the curve even for only one acquisition data. For 

Boxcar Width, specify the number of data points on both side of the point of interest to 

include in the calculation of the moving average. This can reduce the sudden change of 

the curve. This smooths out the sharp variations on the curve: the bigger the Boxcar 

width, the smoother the curve. The following figure demonstrates the smoothing effect 

of a Boxcar width of 10 (maximum value). You can compare it with the former curve 

without smoothing to see the difference (see the red curve in the preview graph). 
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Figure 12-5: New Concentration Measurement - the smoothing effect 

 

Note:  The following example uses the default settings, i.e. no smoothing (Number of 

scans to average=1, Boxcar width=0). 

When all acquisition parameters are set, click Next. 
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Figure 12-6: New Concentration Measurement - Reference Spectrum 

 

Setting Reference Spectrum 

Next, you need to set a "reference spectrum," which is basically the spectrum of the light 

source before you put the test solution in place. Here, you can click on the color patch on 

the window to acquire the live spectrum as the reference. Or, you can use the Browse 

button to load a previous reference spectrum file you saved with SpectraSmart. In this 

example, we use the default option, that is, acquiring the current live spectrum of the 

light source (as such, please don't put the test object in place). Once the reference 

spectrum is captured, you will see it in the preview graph on the lower half of this 

window. Then, click Next. 
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Figure 12-7: New Concentration Measurement - Dark Spectrum 

 

Setting Dark Spectrum 

In addition to the reference spectrum, the software also needs know the readings of the 

light sensor when it is not exposed to light to establish a baseline, i.e. the "dark 

spectrum." So, please cut off or block the light source connected to the spectrometer. 

Then, click on the black-and-white patch on the window to acquire the dark spectrum. 

You can specify the number of scans to average to avoid aberrations of individual scans. 

The default is 1, and we use 10 for example here. Once the dark spectrum is acquired, 

you will see it in the spectrum graph on the lower half of the window, as in the former 

figure. In addition, you will see an "Acquiring dark spectrum..." message window. See the 

following figure: 

 

Figure 12-8: Acquiring dark spectrum... 
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Aside from capturing the real-time dark spectrum, you can also select the program's 

default dark spectrum or load a previous dark spectrum file you saved with SpectraSmart. 

Please note that the default dark spectrum is a set of built-in data which is handy for 

testing purposes. It may not be suitable for your current measurement environment. The 

following figure shows the case when you choose to Use default dark spectrum: 

 

Figure 12-9: New Concentration Measurement - Using the default dark spectrum 

 

Note:  This example uses the dark spectrum captured in real-time (not the default dark 

spectrum). 

Once the dark spectrum is set, click Next. 
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Figure 12-10: New Concentration Measurement - Display Settings 

 

Display Settings 

Next, you can specify a name for the measurement graph window, as well as a spectrum 

title and a color for the graph, as in the former figure. To specify the color, you can click 

on the color patch and select the desired color from the palette: 
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Figure 12-11: Display Settings – Color 

 

When you are done with the display settings, click OK. SpectraSmart then opens the 

Concentration Settings window, which allows you to specify a known concentration 

response curve or the parameters of Beer's Law for the solution being tested, as shown in 

the following figure: 
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Figure 12-12: New Concentration Measurement - Concentration Settings - Calibration Table From Known Concentration 
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Figure 12-13: New Concentration Measurement - Concentration Settings - Beer's Law Settings 

 

Specifying a Known Concentration Response Curve 

Set information for calculating concentration from the measured spectrum. There are two 

ways to do this, either by specifying a calibration table (i.e. the response curve) from 

known concentration or specifying the parameters for the Beer's Law. The following 

example will demonstrate how to create a calibration table: 

1. Place the blue solution of known concentration (assumed to be 1) on the 

measurement holder and select Wavelength on Calibration Table from Known 

Concentration window, and set the Specific wavelength (for the blue solution is 

blue, so it is assumed to be 500 nm) select Wavelength range. 

2. On the Concentration Settings window, input 1 to the Concentration of the 

Calibration Data, and then click Get button to measure the absorbance. 

3. Click Add to List button to add this absorbance to the table on the right. 

4. Next, place another blue solution with a known concentration at the 

measurement holder. Then set the Concentration value as 2, and press the Get 

button again to acquire the absorbance. 
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5. Click the Add to List button to add this absorbance to the table on the right. 

Now, you will see a curve in the Regression Graph. This will be the known concentration 

response curve for the solution to be tested: 

 

Figure 12-14: Configuration of New Concentration Measurement - Concentration Settings 

 

After the response curve is created, you can use the Save Table button on the bottom of 

the window to save this response curve for future use. When you need this curve again, 

just use the Load Table button to load it back. When all settings are done, click Apply to 

apply the settings and the concentration measurement graph will show: 
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Figure 12-15: Newly created concentration measurement graph 

As we haven't put the test solution in place, what we see on the graph is noise. 

Start Measuring the Concentration of the Test Solution 

Next, we put the test solution in place to measure its concentration. As a demonstration, 

we measure the blue solution we used earlier when we created the calibration table. Its 

concentration graph looks like the following:  

 

Figure 12-16: The concentration graph of the test solution 
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The concentration graph in SpectraSmart is basically a real-time strip chart which tracks 

the concentration of the test solution. The former picture shows the tracking of about 1 

minute. The red highlighted area is the measured concentration, while the lower part to 

its left is the initial noise. If it is left to keep running, the entire graph will start to scroll to 

the left when the curve hits the right edge. In the figure, the concentration of the test 

solution varies between 0.5 and 0.6. This looks a little bit unstable. So, we can turn on 

smoothing to smooth out the noises in the acquired data and hence stabilize the curve. 

 

Figure 12-17: Turning on smoothing 

 

Apparently, the smoothing does help reduce fluctuations, as shown in the red highlighted 

area below: 

https://www.als-japan.com/


SpectraSmart User's Guide 12. Concentration Measurement 

  
https://www.als-japan.com/      178 

 

 

Figure 12-18: The effect of turning on smoothing 

 

Checking the Acquired Spectrum Curve 

The concentration curve is calculated from multiple spectrum. SpectraSmart has a 

function to verify the original acquired spectrum curve. Click on the Acquired Spectrum 

button on the toolbar to enable this function, as shown in the following figure: 

 

Figure 12-19: The acquired spectrum of the concentration measurement 
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Graph Toolbar Buttons 

Toolbar button of the density measurement graph and the toolbar of the strip chart are 

basically the same. Please refer to "Graph Toolbar Buttons" in the chapter of strip chart. 

Concentration-related Toolbar Button 

Except for the same toolbar button as the strip chart, there is a button dedicated to 

Concentration Setting for density measurement. See the following figure: 

 

Figure 12-20: The Concentration Setting button 

Concentration Setting button opens the window for you to specify the Calibration Table 

From Known Concentration and Beer's Law Settings. 

Saving the Current Concentration Measurement 

Saving procedure of concentration measurement spectrum is same as absorbance 

spectrum. Please refer to "Saving Absorbance Measurement". 

Loading Saved Concentration Measurement Spectrum 

Loading the concentration measurement spectrum is similar to loading the absorbance 

measurement spectrum. Please refer to "Loading Saved Spectrum Curve of an 

Absorbance Measurement Spectrum". 

Deleting Individual Spectrum of Concentration Measurement 

The result of one concentration measurement is calculated by multiple spectrum curves. 

Therefore, please do not delete either curve. If one of the curves is deleted, the result is 

not calculated correctly. 

Concentration Measurement Print and Preview 

Concentration measurement printing and previewing are the same as spectrum 

measurement. Please refer to "Printing and Previewing a Spectrum Measurement Print 

and Preview". 
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13. Trigger Mode Settings 

The spectrometers come with an I/O port to support the "trigger mode". In the trigger 

mode, the control of spectrometer is controlled with external I/O signal. 

The user can trigger multiple devices simultaneously, instead of sending multiple 

commands the devices through API, triggering through I/O signals can capture data with 

instructions to multiple spectrometers at the same time without being influenced by the 

computer performance. 

Enabling the Trigger Mode (I/O Signal) 

Before using the trigger mode, you need to enable it in SpectraSmart. First, create a 

spectrum measurement. 

 

Figure 13-1: Create a new spectrum measurement 

In the Spectrum List pane on the left side of the screen, check to see if the current 

acquisition mode is Trigger Off(by default), as in the following picture: 
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Figure 13-2: The acquisition mode in the Spectrum List shows Trigger Off 

 

Next, select Trigger Settings from the Settings menu: 

 

 

Figure 13-3: Select Trigger Settings from the Settings menu 

 

The Trigger Settings window shows:  
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Figure 13-4: Enabling the trigger mode (I/O Signal) 

Now, follow these steps: 

1. Select the spectrum measurement for which you want to enable the trigger mode 

("Spectrum_0" in this case). 

2. Select your Trigger Mode (In this case is SW Continuous Trigger mode). 

3. Click the Enable button to put the measurement into the trigger mode. 

4. Click OK to exit this window.  

Now the spectrum acquisition mode should show Trigger Mode, as in the following 

picture: 

1 

2 

3 4 
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Figure 13-5: Confirming if the spectrum acquisition mode is now in Trigger Mode 

 

In addition, you will notice that the spectrum graph is not updating anymore because it is 

waiting on the external I/O signal to start data acquisition. 

Activation of trigger mode (spectrum intensity) 

When this mode is used, start/stop control of measurement can be performed depending 

on the set spectrum intensity. Measurement is started when the set spectrum intensity 

exceeds a certain point, and measurement is stopped when the intensity increased below 

the set intensity at all measurement points. 

From the Trigger setting screen, follow the procedure below to make settings. 

1. Select the spectrum measurement for which you want to enable the trigger mode 

("Spectrum_0" in this case). 

2. Check SW Intensity Trigger. 

3. Set the spectrum intensity to Counter (i.e. 50000). 

4. Click the Enable button to put the measurement into the trigger mode. 

5. Click OK to exit this window. 

This sets the spectrum acquisition mode to the intensity trigger mode. 

By enabling Raw data, raw data not subjected to correction and smoothing processing 

will be reflected in the trigger. 
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Figure 13-6: Disabling the trigger mode 

 

Disabling the Trigger Mode 

To disable the trigger mode, select Trigger Settings from the Settings menu. Then, in the 

Trigger Settings windows, follow the steps below: 

1. Select the spectrum measurement for which you want to "disable" the trigger 

mode ("Spectrum_0" in this case). 

2. Select Trigger Mode in Trigger Off mode. 

3. Click Enable to put the measurement back to the trigger off mode. 

4. Click OK to exit this window.  

See the following figure:  

1 

2 

5 

3 

4 
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 Figure 13-7: Disabling the trigger mode 

 

Now, in the Spectrum List pane, you will find that the acquisition mode is back toTrigger 

Off. 

1 

2 

4 
3 
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 Figure 13-8: Confirming if the spectrum acquisition mode is Trigger Off 
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14. Time Sequence 

SpectraSmart has the Time Sequence function that monitors changes in measured values 

over certain period of time. When you move the mouse cursor over the vertical Time 

Sequence button on the right and of the SpectraSmart window, the Time Sequence 

window opens. 

 

Figure 14-1: The Time Sequence button and the Time Sequence pane 

When you move the mouse, the window closes automatically. If you want it to stay on the 

screen, you can click on the push-pin icon on the upper-right corner of the pane to fix it. 

See the following figure: 

 

Figure 14-2: The push-pin for pinning the Time Sequence pane 
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Click the pin icon to display the "Time Sequence" pane, which size has been adjusted. 

 

Figure 14-3: The pinned Time Sequence pane 

 

Start Recording Continuous Changes 

Refer to the figure above. Now we demonstrate how to use the Time Sequence feature in 

a spectrum measurement. 

Specifying a Folder to Save the Captured Data 

First, you need to specify the folder to save the recorded data. The default is the desktop. 

If necessary, it is possible to change it using the Save In button on the top of this pane. 

Specifying When to Start 

Next, set the start time. The default is 1 millisecond (ms) after you chick the Record 

button, recording starts. Never set zero (0) here, or there will be an error. 

If you want to start record immediately, press the Record button, and check Start. 
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Specifying the Acquisition Interval 

You can set an acquisition interval for the recording. The default interval is 500 ms, if 

necessary, it can be changed. Alternatively, you can choose "Synchronize with source" to 

keep an equal acquisition interval of the original spectrum. 

Specifying When to Stop 

Next, specify the stop time. The default is until click the Stop button, or stop can be 

setting. 

Specifying What Spectrum Curves to Record 

Last, specify the spectrum to be saved. The default is all the measured spectrum curves. A 

typical spectrum measurement (as in this case) has only one spectrum curve, but other 

measurements including absorbance, transmittance, reflectance, light source, and 

concentration have four spectrum curves in a single measurement. In the spectrum list on 

the upper part of this pane, please select the spectrum curves to be recorded. 

If Create file at every tracking interval is not checked, it will be saved as a file format 

dedicated to time series measurement (extension spc), and can be played from File -> 

Open Time Sequence File. If Open Time Sequence File is not checked, it is saved in file 

format according to each measurement mode at each data acquisition interval 

(extension: sps), which can be open from File -> Open Spectrum File. 

Start Recording 

After setting the above options, if Only record new data is checked, pressing the Record 

button (red point), at the top of the window, the following prompt message will be 

displayed. Press OK to start record. 

 

Figure 14-4: If you enable Only record new data while performing multiple measurements, the message Please only execute 

one measurement for each spectrometer or there is a risk of losing part of data is displayed  
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Stop Recording 

If you have specified the time of recording, it automatically stops at the set time. For the 

stop of the recording, press the Stop button at the top of the pane to stop recording. 

Loading and Playing Back a Previous Recorded Time Sequence 

The data saved without checking Create file at every tracking interval can be read from 

Open Time Sequence File in the File menu. 

 

 

Figure 14-5: Selecting Open Time Sequence File from the File menu 

 

This opens the system standard Open window. Now locate the file you saved earlier, and 

then click the Open button. 

 

Figure 14-6: Selecting previously saved file in the Open window 
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Once the file is opened, SpectraSmart will display the playback tools for the time 

sequence file. 

 

Figure 14-7: The playback tools for the time sequence file 

As shown in the above figure, there are buttons that allows the user to Rewind, Play, 

Pause, and Fast-forward the playback of time sequence (see the red highlighted area 

near the bottom). These buttons work just like the way they do in video playback. 

Through playback, you can easily go back and forth to find out how the measurement 

reading changes. Moreover, you will notice that the time sequence file will keep playing 

over and over again once it is loaded until you press the Pause button.
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15.Application Settings 

In Spectra Smart, you can customize default values such as wavelength display range, 

background color of a measurement graph, the default smoothing settings, etc. 

To change these settings, select Application Settings from the Settings menu. 

  

Figure 15-1: Selecting Application Settings from the Settings menu 

 

Next, the Application Settings window opens. 

  

Figure 15-2: The Default Settings tab of the Application Settings  
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Default Settings 

Default Settings it allows the configuration of some default. 

Display Range: Start and End 

In the Application Settings, Default Settings window, Display range start and Display 

range end of the X-axis can be configured. 

Average 

This setting allows specifying the default number of scan average number. This averaging 

reduces the influence of noise. 

Boxcar 

This setting allows specifying the default for the Boxcar smoothing. It varies from 0 to 10, 

the higher the number, the smoother the curve. The default value is 0, i.e. no smoothing. 

Display a Message when the Peak Value in the Spectrum Exceeds 65535 

The maximum value supported in the spectrum data is 65535. Therefore, when the "peak 

value" of the spectrum exceeds this value, the spectrum curve will not be accurate, and a 

warning message is displayed on the spectrum diagram. 
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Figure 15-3: The data distorted warning message 

 

Save 

You can set the method of saving measurement data in Save.  
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Figure 15-4: The Save tab of the Application Settings 

 

Wavelength Range 

The start and end points can be changed by checking Enabled. If Enabled is not checked, 

a wavelength range of 200 to 1025 nm, specific of the device, is setting. 

Wavelength Resolution 

Check Enabled and specify the wavelength resolution from among 0.01, 0.05, 0.1, 0.2, 0.3, 

0.4, 0.5, 0.6, 0.7, 0.8, 0.9, 1, 5, 10. If Enabled is not checked, 0.01 will be setting. 
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File 

When right-click in the spectrum data frame and you can select one or more file format 

as, Save all spectra in ... (refer to 6. Spectrum measurement -> Save current spectrum 

diagram -> Save all spectra in current window) and, when using Record setting of Script 

chart, Save record (refer to 7. 7. Strip Chart (Tracking Specific Wavelengths) -> Record 

Setting Buttons).  
 

Graph 

This tab allows adjusting the graph display on the window. 

Line Width 

This controls the line width of the curve on a graph. 

Window Background and Chart Background 

These two control the background styles and colors of the measurement window and the 

measurement graph, respectively. The available styles are None, Brush, and Solid:  

  

Figure 15-5: The Graph tab of Application Settings - Window background 
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The following figure demonstrates a Window background in solid gray and a Graph 

background in brushed light blue: 

 

Figure 15-6: Demonstrating background effects in the Application Settings 

 

Human Visible Spectrum 

This allows you to show the visible spectrum on the graph along with the measurement 

curve. See the former figure. 

 

Note:  For these graph settings, you can click "Apply" to see the effect of a change 

immediately. 
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Smoothing 

This tab lets you control whether you want to enable smoothing by default. 

 

Figure 15-7: The Smoothing tab of Application Settings 

 

DWT Denoise Filter 

Here you specify whether to use the Discrete wavelet transform denoise filter (DWT 

Denoise Filter). To use it, simply select the Enable Filter check box. 

Savitzky-Golay Filter 

Here you specify whether to use the Savitzky-Golay filter. To use it, select the Enable filter 

check box, and then specify the smoothing Degree and the smoothing Mode. The 

available modes are Reference Curve, Reference & Measurement Curve, and 

Measurement Curve. 
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FFT Filter 

Here you specify whether to use the Fast Fourier Transform (FFT) filter. To use it, select 

the Enable filter check box, and then specify a Threshold value. 

Running Average 

Here you specify whether to use the running average algorithm. To use it, select Enable 

running average, and then specify the number of points to include in the average. 

Kalman Filter 

Here you specify whether to use the Kalman filter. To use it, simply select the Enable filter 

check box. 

Long Pass Filter 

Here you specify whether to use the long pass filter. To use it, simply select the Enable 

filter check box. 

Note:  You can click "Apply" to see the effect immediately after you change these 

smoothing settings. 
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Color Information 

Here you can customize the fields displayed in the Colorimetry pane. See the following 

figure: 

 

Figure 15-8: The Color Information tab of Application Settings 
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16.Other Miscellaneous Features 

In addition to the main features described in previous chapters, there are a few other 

miscellaneous features that allow you to work more easily. 

Language 

The language used in the program interface can be changed. In the File menu, select 

Language: 

 

Figure 16-1: Selecting Language from the File menu 

 

When you finished selecting it, the program window will change to the corresponding 

language immediately. For demonstration, we change the language to Japanese in the 

following figure: 
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Figure 16-2: The effect of switching the display language to Japanese 

 

Font 

In addition to the display language, you can also adjust the size of the font for the user 

interface. Go to the View menu, and then select the Font: 

 

Figure 16-3: Selecting Font from the View menu 

 

You can choose the font size that best fits your needs. 
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Default Layout 

Once you have more than one measurement windows and you have moved the windows 

around, you can go to the Window menu and select Default Layout to revert to their 

default layout: 

 

Figure 16-4: Selecting Default Layout from the Window menu 

 

The window layout now reverts back to the way it originally was: 

Figure 16-5: The default window layout of the program 
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17.Program Version and Contact Information 

This concludes our introduction to all features of SpectraSmart. Hopefully, these chapters 

will help you get up to speed with SpectraSmart as a new user. If you have any further 

questions about SpectraSmart or any suggestions to this guide, please do not hesitate to 

let us know. You can find our contact information in SpectraSmart by going to the Help 

menu then selecting About. You will see the version information of your SpectraSmart as 

well as our contact information: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Manufactured by: 
 

ALS Co., Ltd 
 
Exclusive distributor: 
 

BAS Inc. 
 
Address: 1-28-12, Mukojima, Sumida-ku, Tokyo 131-0033, JAPAN 
Phone:   +81-3-3624-0331 
Fax:   +81-3-3624-3387 
URL:  https://www.als-japan.com/ 
Email:  sales@als-japan.com 
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Appendix A: Spectrometer Correction Features 

Electronic Dark Correction  

A basic electric current constantly flows through the electronic systems (such as the main 

board and the CCD sensor) of the BAS spectrometer whenever the spectrometer is on. 

This is called the "dark current," meaning this current exists even though no light enters 

the spectrometer. The analog-to-digital converter (ADC) will also convert this dark current 

into measurement readings across the entire spectrum, forming the baseline. Before 

shipment, BAS spectrometer will be factory-calibrated to an assumed baseline of 1,000 as 

the dark current. Since the dark current is not triggered by the light entering the 

spectrometer, this baseline needs to be deducted from the readings. As the level of the 

dark current can be affected by the device temperature, BAS has designed an algorithm 

to dynamically correct the readings in relation to the dark current. This is called the 

"electronic dark correction," a process which each BAS spectrometer must go through 

before shipment, and the correction data is directly stored within the spectrometer. 

When the electronic dark correction is enabled in the SpectraSmart software, the dark 

current will be dynamic removed from the measurement curve. The following figures 

show two different measurement curves without and with electronic dark correction, 

respectively: 

 

Figure A-1: Without electronic dark correction 
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Figure A-2: With electronic dark correction 

To enable electronic dark correction, click on the Electronic Dark Correction button above 

the toolbar. To disable it, just click on the button again. See the following figure: 

 

Figure A-3: The Electronic Dark Correction button 

 

Linearity Correction 

The response curve of the CCD sensor in relation to the light intensity is not a perfect 

straight line. In addition, the response curve of each CCD sensor will not be identical to 

each other. For this reason, each BAS spectrometer will go through a "linearity 

correction" process before it is shipped, with its own correction table store within the 

spectrometer. As BAS spectrometer uses a 16-bit ADC internally, its output readings will 

be calibrated to the range between 0 and 65535. When linearity correction is enabled in 

the SpectraSmart software, the reading for each pixel will be corrected using this table. 

See the following figure for the difference: 
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Figure A-4: Without linearity correction 

  
Figure A-5: With linearity correction 

To enable linearity correction in SpectraSmart, click on the Linearity Correction button 

(next to the Electronic Dark Correction) above the toolbar. To disable it, just click on the 

button again. See the following figure: 

 

Figure A-6: The Linearity Correction button 

 

Intensity Correction 

The spectrometer CCD sensor has different response to wavelength. Therefore, before 

shipping the spectrometer to the factory, we save the correction table in the 

spectrometer to correct the intensity. Standard intensity light source is used for strength 

correction. In addition, intensity correction (350 to 900 nm) is also performed at the SMA 

https://www.als-japan.com/


SpectraSmart User's Guide Appendix A: Spectrometer Correction Features 

  
https://www.als-japan.com/      208 

 

905 connector end. In order to independently measure the light source intensity by the 

user, it is necessary to build an independently system. 

 
Figure A-7: Without intensity correction 

 
Figure A-8: With intensity correction 

 

To enable intensity correction in the SpectraSmart software, click on the Intensity 

Correction button above the toolbar. See the following figure: 

 

Figure A-9: The Intensity Correction button 
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